CH A P T E R

17

Create Optical Channel Circuits and
Provisionable Patchcords
This chapter explains the Cisco ONS 15454 dense wavelength division multiplexing (DWDM) optical
channel (OCH) circuit types and virtual patchcords that can be provisioned on the ONS 15454. Circuit
types include the OCH client connection (OCHCC), the OCH trail, and the OCH network connection
(OCHNC). Virtual patchcords include internal patchcords and provisionable (external) patchcords
(PPCs). This chapter also describes 17.3 End-to-End SVLAN Circuit that can be created between
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards.
This chapter explains how to create Cisco ONS 15454 dense wavelength division multiplexing (DWDM)
optical channel client connections (OCHCCs), optical channel network connections (OCHNCs), optical
trail circuits, and STS circuits. The chapter also tells you how to create provisionable patchcords,
upgrade OCHNCs to OCHCCs, manage SVLANs for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards, and manage overhead circuits.

Note

Unless otherwise specified, “ONS 15454" refers to both ANSI and ETSI shelf assemblies.

Note

In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to
the 15454-M-RAMAN-COP card.

Note

In this chapter, the “NFV view” refers to the “DWDM Network Functional View (NFV)”. The “GMPLS
view” refers to the “DWDM Network Functional View (GMPLS)”.

Note

In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card.

17.1 Optical Channel Circuits
The ONS 15454 DWDM optical circuits provide end-to-end connectivity using three OCH circuit types:
•

Optical Channel Network Connections (OCHNC)

•

Optical Channel Client Connections (OCHCC)
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17.1.1 OCHNC Circuits

•

Optical Channel Trails (OCH Trails)

A graphical representation of OCH circuits is shown in Figure 17-1.
Figure 17-1
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17.1.1 OCHNC Circuits
OCHNC circuits establish connectivity between two optical nodes on a specified C-band wavelength.
The connection is made through the ports present on the wavelength selective switches, multiplexers,
demultiplexer, and add/drop cards. In an OCHNC circuit, the wavelength from a source OCH port
ingresses to a DWDM system and then egresses from the DWDM system to the destination OCH port.
The source and destination OCH port details are listed in Table 17-1.
Table 17-1

OCHNC Ports

Card

Source Ports

Destination Ports

32WSS

ADD-RX

—

CHAN-RX

—

—

CHAN-TX

CHAN-RX

CHAN-TX

ADD-RX

DROP-TX

32WSS-L
40-WSS-C
40-WSS-CE
32MUX-O
40-MUX-C
32DMX-O
32DMX
32DMX-L
40-DMX-C
40-DMX-CE
4MD
AD-1C-xx.x
AD-4C-xx.x
40-SMR1-C
40-SMR2-C
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Table 17-1

OCHNC Ports (continued)

Card

Source Ports

Destination Ports

15216-MD-40-ODD

CHAN-RX

CHAN-TX

CHAN-RX

CHAN-TX

CHAN-RX

CHAN-TX

CHAN-RX

CHAN-TX

15216-MD-40-EVEN
15216-EF-40-ODD
15216-EF-40-EVEN
15216-MD-48-ODD
15216-MD-48-EVEN
15216-FLD-4

Note

When the 40-SMR1-C or 40-SMR2-C card operates along with the 15216-MD-40-ODD,
15216-EF-40-ODD, or 15216-MD-48-ODD (ONS 15216 40 or 48-channel mux/demux) patch panel, the
OCH ports on the patch panel are the endpoints of the OCHNC circuit.
When the 40-SMR1-C or 40-SMR2-C card operates along with the 40-MUX-C and 40-DMX-C cards,
the endpoints of the OCHNC circuit are on the MUX/DMX cards.

17.1.2 OCHCC Circuits
OCHCC circuits extend the OCHNC to create an optical connection from the source client port to the
destination client port of the TXP/MXP cards. An OCHCC circuit represents the actual end-to-end client
service passing through the DWDM system.
Each OCHCC circuit is associated to a pair of client or trunk ports on the transponder (TXP), muxponder
(MXP), GE_XP (in layer-1 DWDM mode), 10GE_XP (in layer-1 DWDM mode), or ITU-T line card.
The OCHCCs can manage splitter protection as a single protected circuit. However, for the Y-Cable
protection, two OCHCC circuits and two protection groups are required.

17.1.3 OCH Trail Circuits
OCH trail circuits transport the OCHCCs. The OCH trail circuit creates an optical connection from the
source trunk port to the destination trunk port of the Transponder (TXP), Muxponder (MXP), GE_XP,
10GE_XP, or ITU-T line card. The OCH trail represents the common connection between the two cards,
over which all the client OCHCC circuits, SVLAN circuits or STS circuits are carried.
Once an OCHCC is created, a corresponding OCH Trail is automatically created. If the OCHCC is
created between two TXP, MXP, GE_XP, or 10GE_XP cards, two circuits are created in the CTC. These
are:
One OCHCC (at client port endpoints)
One OCH trail (at trunk port endpoints)
If the OCHCC is created between two TXPP or two MXPP cards, three circuits are created in the CTC.
These are:
•

One OCHCC (at client port endpoints)
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17.1.3 OCH Trail Circuits

•

Two OCH Trails (at trunk port endpoints)
One for the working and other for the protect trunk.

Note

On a TXP, MXP, and GE_XP card (in layer 1 DWDM mode), additional OCHCC circuits are created
over the same OCH trail.

Note

On a TXP, MXP, GE_XP (in layer 1 DWDM mode), and 10GE_XP (in layer 1 DWDM mode) card, the
OCH trail cannot be created independently, and is created along with the first OCHCC creation on the
card. However, on a GE_XP card (in layer-2 DWDM mode), 10GE_XP card (in layer-2 DWDM mode),
and ADM_10G card, an OCH trail can be created between the trunk ports for the upper layer circuits
(SVLAN in GE_XP/10GE_XP and STS in ADM_10G). No OCHCC is supported in these cases.
If the OCHCC is created between two ITU-T line cards, only one trunk port belongs to the OCHCC at
each end of the circuit. Table 17-2 lists the ports that can be OCHCC and OCH trail endpoints.
Table 17-2

OCHCC and OCH Trail Ports

Card

OCHCC

OCH Trail

TXPs

Any client port

Any trunk port

Any trunk port

Any trunk port

MXPs
GE_XP
10GE_XP
ADM-10G
ITU-T line cards:
•

OC48/STM64 EH

•

OC192 SR/STM64

•

MRC-12

•

MRC-2.5-12

•

MRC-2.5G-4

Figure 17-2 shows the relationships and optical flow between the OCHCC, OCH trail, and OCHNC
circuits.
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Figure 17-2
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17.1.4 Administrative and Service States
OCHCCs, OCH trails, and OCHNCs occupy three different optical layers. Each OCH circuit has its own
administrative and service states. The OCHCCs impose additional restrictions on changes that can be
made to client card port administrative state.
The OCHCC service state is the sum of the OCHCC service state and the OCH trail service state. When
creating an OCHCC circuit, you can specify an initial state for both the OCHCC and the OCH trail
layers, including the source and destination port states. The ANSI/ETSI administrative states for the
OCHCC circuits and connections are:
•

IS/Unlocked

•

IS,AINS/Unlocked,AutomaticInService

•

OOS,DSBLD/Locked,disabled

OCHCC service states and source and destination port states can be changed independently. You can
manually modify client card port states in all traffic conditions. Setting an OCHCC circuit to
OOS,DSBLD/Locked,disabled state has no effect on OCHCC client card ports.
An OCH trail is created automatically when you create an OCHCC. OCH trails can be created
independently between OCH-10G cards and GE_XP and 10GE_XP when they are provisioned in
Layer 2 Over DWDM mode. The OCH trail ANSI/ETSI administrative states include:
•

IS/Unlocked

•

IS,AINS/Unlocked,automaticInService

•

OOS,DSBLD/Locked,disabled

You can modify OCH trail circuit states from the Edit Circuit window. Placing an OCH trail
OOS,DSBLD/Locked,disabled causes the following state changes:
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•

The state of the OCH trail ports changes to OOS,DSBLD/Locked,disabled.

•

The OCHNC state changes to OOS,DSBLD/Locked,disabled.

Changing the OCH trail state to IS,AINS/Unlocked,automaticInService causes the following state
changes:
•

The state of the OCH trail trunk ports changes to IS/Unlocked.

•

The OCHNC state changes to IS,AINS/Unlocked,automaticInService.

The OCH trail service state is the sum of the OCHCC trunk port state and the OCHNC (if applicable)
state. Changing the client card trunk ports to OOS,DSBLD/Locked,disabled when the OCH trail state
IS/Unlocked will cause the OCH trail state to change to OOS,DSBLD/Locked,disabled and its status to
change to Partial.
The OCHNC circuit states are not linked to the OCHCC circuit states. The administrative states for the
OCHNC circuit layer are:
•

IS,AINS/Unlocked,AutomaticInService

•

OOS,DSBLD/Locked,disabled

When you create an OCHNC, you can set the target OCHNC circuit state to IS/Unlocked or
OOS,DSBLD/Locked,disabled. You can create an OCHNC even if OCHNC source and destination ports
are OOS,MT/Locked,maintenance. The OCHNC circuit state will remain
OOS-AU,AINS/Unlocked-disabled,automaticInService until the port maintenance state is removed.
During maintenance or laser shutdown, the following behavior occurs:
•

If OCHNCs or their end ports move into an AINS/AutomaticInService state because of user
maintenance activity on an OCHCC circuit (for example, you change an optical transport section
(OTS) port to OOS,DSBLD/Locked,disabled), Cisco Transport Controller (CTC) suppresses the
loss of service (LOS) alarms on the TXP, MXP, GE_XP, 10GE_XP, or ITU-T line card trunk ports
and raises a Trail Signal Fail condition. Line card trunk port alarms are not changed, however.

•

If TXP client or trunk port are set to OOS,DSBLD/Locked,disabled state (for example, a laser is
turned off) and the OCH trunk and OCH filter ports are located in the same node, the OCH filter
LOS alarm is demoted by a Trail Signal Fail condition.

OCHCCs are associated with the client card end ports. Therefore, the following port parameters cannot
be changed when they carry an OCHCC:
•

Wavelength

•

Service (or payload type)

•

Splitter protection

•

ITU-T G.709

•

Forward error correction (FEC)

•

Mapping

Certain OCHCC parameters, such as service type, service size, and OCHNC wavelength can only be
modified by deleting and recreating the OCHCC. If the OCHCC has MXP end ports, you can modify
services and parameters on client ports that are not allocated to the OCHCC. Some client port
parameters, such as Ethernet frame size and distance extension, are not part of an OCHCC so they can
be modified if not restricted by the port state. For addition information about administrative and service
states, see the Administrative and Service States document.
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17.1.5 Creating and Deleting OCHCCs
To create an OCHCC, you must know the client port states and their parameters. If the client port state
is IS/Unlocked, OCHCC creation will fail if the OTN line parameters (ITU-T G.709, FEC, signal fail bit
error rate (SF BER), and signal degrade bit error rate (SD BER) on the OCHCC differ from what is
provisioned on the trunk port. The port state must be changed to OOS-DSLB/Locked,disabled in order
to complete the OCHCC.
If you delete an OCHCC, you can specify the administrative state to apply to the client card ports. For
example, you can have the ports placed in OOS,DSBLD/Locked,disabled state after an OCHCC is
deleted. If you delete an OCHCC that originates and terminates on MXP cards, the MXP trunk port states
can only be changed if the trunk ports do not carry other OCHCCs.

17.1.6 OCHCCs and Service and Communications Channels
Although optical service channels (OSCs), generic communications channels (GCCs), and data
communications channels (DCCs) are not managed by OCHCCs, the following restrictions must be
considered when creating or deleting OCHCCs on ports with service or communication channels:
•

Creating an OCHCC when the port has a service or a communications channel is present—OCHCC
creation will fail if the OCHCC parameters are incompatible with the GCC/DCC/GCC. For
example, you cannot disable ITU-T G.709 on the OCHCC if a GCC carried by the port requires the
parameter to be enabled.

•

Creating a service or communications channel on ports with OCHCCs—OCHCC creation will fail
if the GCC/DCC/GCC parameters are incompatible with the OCHCC.

•

Deleting an OCHCC on ports with service or communications channels—If an OSC/GCC/DCC is
present on a TXP, MXP, GE_XP, 20GE_XP, or ITU-T line card client or trunk port, you cannot set
these ports to the OOS,DSBLD/Locked,disabled state after the OCHCC circuit is deleted.

17.1.7 Related Procedures
•

NTP-G151 Create, Delete, and Manage Optical Channel Client Connections, page 17-15

•

NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-34

•

NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-41

•

NTP-G58 Locate and View Optical Channel Circuits, page 17-71

17.2 Virtual Patchcords
The TXP, MXP, TXPP, MXPP, GE_XP, 10GE_XP, and ADM-10G client ports and DWDM filter ports
can be located in different nodes or in the same single-shelf or multishelf node. ITU-T line card trunk
ports and the corresponding DWDM filter ports are usually located in different nodes.
OCHCC provisioning requires a virtual patchcord between the client card trunk ports and the DWDM
filter ports. Depending on the physical layout, this can be an internal patchcord or a provisionable
(external) patchcord (PPC). Both patchcord types are bidirectional. However, each direction is managed
as a separate patchcord.
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17.2 Virtual Patchcords

Internal patchcords provide virtual links between the two sides of a DWDM shelf, either in single-shelf
or multishelf mode. They are viewed and managed in the Provisioning > WDM-ANS >
Internal Patchcords tab.
When the NE update file is imported in CTC, the Provisioning > WDM-ANS > Internal Patchcord tab is
populated with the internal patchcords. When you create an internal patchcord manually, the Internal
Patchcord Creation wizard prompts you to choose one of the following internal patchcord types:

Note

•

Trunk to Trunk (L2)—Creates an internal patchcord between two trunk ports (in NNI mode) of a
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card provisioned in the L2-over-DWDM mode.

•

OCH-Trunk to OCH-Filter—Creates an internal patchcord between the trunk port of a TXP, MXP,
GE_XP, 10GE_XP, or ITU-T line card, and an OCH filter card (wavelength selective switch,
multiplexer, or demultiplexer).

•

OCH-Filter to OCH-Filter—Creates an internal patchcord between a MUX input port and a DMX
output port.

•

OTS to OTS—Creates an internal patchcord between two OTS ports.

•

Optical Path—Creates an internal patchcord between two optical cards, or between an optical card
and a passive card.

If a Side-to-Side PPC is created between nodes, it will no longer function if the node Security Mode
mode is enabled (see the “DLP-G264 Enable Node Security Mode” procedure on page 14-25). When the
Secure mode is enabled, it is no longer possible for the DCN extension feature to use the LAN interface
to extend the internal network (due to the network isolation in this configuration mode). The result is
that the topology discovery on the Side-to-Side PPC no longer operates.
Table 17-3 shows the internal patchcord Trunk (L2), OCH trunk, OCH filter, and OTS/OCH ports.
Table 17-3

Internal Patchcord Ports

Card

Trunk (L2) Port

OCH Trunk Ports

OCH Filter Ports

OTS/OCH Ports

GE_XP

Trunk port in NNI
mode

Any trunk port

—

—

—

Any trunk port

—

—

—

—

—

COM-TX

10GE_XP
GE_XPE
10GE_XPE
TXPs
MXPs
ADM-10G
ITU-T line cards
OPT-BST
OPT-BST-E

COM-RX

OPT-BST-L

OSC-TX
OSC-RX
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Table 17-3

Internal Patchcord Ports (continued)

Card

Trunk (L2) Port

OCH Trunk Ports

OCH Filter Ports

OTS/OCH Ports

OPT-AMP-17-C

—

—

—

COM-TX

OPT-AMP-L

COM-RX
OSC-TX1
OSC-RX1
DC-TX1
DC-RX1

OPT-PRE

—

—

—

COM-TX
COM-RX
DC-TX
DC-RX

OSCM

—

—

—

OSC-CSM

COM-TX
COM-RX
OSC-TX
OSC-RX

32MUX

—

—

Any CHAN RX port

COM-TX

—

—

Any CHAN TX port

COM-RX

—

—

Any ADD port

COM-TX

32MUX-O
40-MUX-C
32DMX
32DMX-L
32DMX-O
40-DMX-C
40-DMX-CE
32WSS
32WSS-L

COM-RX

40-WSS-C

EXP-TX

40-WSS-CE

EXP-RX
DROP-TX

40-WXC-C

—

—

—

ADD-RX
DROP-TX
COM TX
COM RX
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Table 17-3

Internal Patchcord Ports (continued)

Card

Trunk (L2) Port

OCH Trunk Ports

OCH Filter Ports

OTS/OCH Ports

80-WXC-C

—

—

—

EAD i, i=1 to 8
AD
COM
COM-RX
DROP-TX
EXP-TX

MMU

—

—

—

EXP A TX
EXP A RX

1. When provisioned in OPT-PRE mode.

PPCs are created and managed from the network view Provisioning > Provisionable Patchcord (PPC) tab
(Figure 17-3), or from the node view (single-shelf mode) or multiself view (multishelf mode)
Provisioning > Comm Channel > PPC tab.
Figure 17-3

Network View Provisionable Patchcords Tab
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PPCs are required when the TXP, MXP, GE_XP, 10GE_XP, ADM-10G, or ITU-T line card is installed
in a different node than the OCH filter ports. They can also be used to create OTS-to-OTS links between
shelves that do not have OSC connectivity. PPCs are routable and can be used to discover network
topologies using Open Shortest Path First (OSPF). GCCs and DCCs are not required for PPC creation.
When you create a PPC, the PPC Creation wizard asks you to choose one of the following PPC types:
•

Client/Trunk to Client/Trunk (L2)—Creates a PPC between two client or trunk ports (in NNI mode)
on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards provisioned in the L2-over-DWDM mode.

•

Client/Trunk to Client/Trunk—Creates a PPC between two client or trunk ports on TXP, MXP,
GE_XP, 10GE_XP, ADM_10G, or ITU-T line cards.

•

Side to Side (OTS)—Creates a PPC between two OTS ports that belong to a Side. This option
establishes data communications network (DCN) connectivity between nodes that do not have
OSCM or OSC-CSM cards installed and therefore do not have OSC connectivity. CTC selects the
OTS ports after you choose the origination and termination sides.

•

OCH Trunk to OCH Filter—Creates a PPC between a OCH trunk port on a TXP, MXP, GE_XP,
10GE_XP, ADM-10G, or ITU-T line card and an OCH filter port on a multiplexer, demultiplexer,
or wavelength selective switch card.

Table 17-4 shows the PPC Client/Trunk (L2), Client/Trunk, OTS, and OCH Filter ports.
Table 17-4

Provisionable Patchcord Ports

Card
GE_XP
10GE_XP

Client/Trunk (L2)
Port

Client/Trunk Port

OTS Port

OCH Filter Port

Client or trunk
Any trunk port
port in NNI mode

—

—

—

Any trunk port

—

—

—

—

COM RX1

—

GE_XPE
10GE_XPE
TXPs
MXPs
ADM-10G
ITU-T line cards
OPT-BST
OPT-BST-E

LINE RX

OPT-BST-L

LINE TX

OPT-AMP-17-C

—

—

OPT-AMP-L

COM RX2
COM TX

—

3

LINE RX3
LINE TX3
OPT-PRE

—

—

COM RX4
COM TX

OSC-CSM

—

—

—

4

COM RX1

—

LINE RX
LINE TX
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17.2.1 PPC Provisioning Rules

Table 17-4

Provisionable Patchcord Ports (continued)

Card

Client/Trunk (L2)
Port

Client/Trunk Port

OTS Port

OCH Filter Port

32MUX

—

—

—

Any CHAN RX
port

—

—

—

Any CHAN TX
port

—

—

—

Any ADD port

—

—

COM RX

—

32MUX-O
40-MUX-C
32DMX
32DMX-L
32DMX-O
40-DMX-C
40-DMX-CE
32WSS
32WSS-L
40-WSS-C
40-WSS-CE
40-WXC-C

COM TX
80-WXC-C

—

—

EAD i, i=1 to 8 —
AD
COM
COM-RX
DROP-TX
EXP-TX

40-SMR1-C

—

—

40-SMR2-C
MMU

LINE RX

—

LINE TX
—

—

EXP A RX

—

EXP A TX
1. Line nodes only.
2. When card mode is OPT-PRE.
3. When card mode is OPT-LINE.
4. Line nodes with two OPT-PRE cards and no BST cards installed.

For related procedure, see NTP-G184 Create a Provisionable Patchcord, page 17-78

17.2.1 PPC Provisioning Rules
For Client/Trunk to Client/Trunk (L2) PPCs, the following provisioning rules and conditions apply:
•

The card must be provisioned in the L2-over-DWDM mode.

•

The client or trunk ports must be in the NNI mode.
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•

PPCs can be created only between NNI ports of the same size (1GE-1GE or 10GE-10GE).

•

A wavelength check is not performed during L2 trunk-to-trunk patchcord provisioning. The source
and destination wavelengths of a L2 trunk-to-trunk PPC can be different.

For Client/Trunk to Client/Trunk PPCs, the following provisioning rules and conditions apply:
•

Patchcords can be created on preprovisioned or physically installed cards.

•

Trunk-to-trunk connections require the same wavelength if the port is equipped. A wavelength check
is automatically performed during patchcord provisioning.

•

For connections involving one or more preprovisioned ports, no compatibility check is performed.

For OCH Trunk to OCH Filter PPCs, the following provisioning rules and conditions apply:
•

GCC and DCC links are not required to create a PPC.

•

PPCs can be created for preprovisioned or physically installed cards.

•

OCH trunk and OCH filter ports must be on the same wavelength. CTC checks the ports for
wavelength compatibility automatically during PPC provisioning.

•

For OC-48/STM-16 and OC-192/STM-64 ITU-T line cards, the wavelength compatibility check is
performed only when the cards are installed. The check is not performed for preprovisioned cards.

•

For all other preprovisioned cards, a wavelength compatibility check is not performed if card is set
to first tunable wavelength. The wavelength is automatically provisioned on the port, according to
the add/drop port that you chose when you created the PPC.

For related procedures, see NTP-G200 Create, Delete, and Manage STS or VC Circuits for the
ADM-10G Card, page 17-55

17.3 End-to-End SVLAN Circuit
An end-to-end SVLAN circuit can be created between GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards through a wizard in CTC. SVLAN circuits created this way are only a snapshot of the SVLAN
settings (NNI and QinQ) of each card in the network. If an end-to-end SVLAN circuit is created via CTC
and the SVLAN settings of the cards are changed manually, CTC does not update the SVLAN circuit
created with the new settings. To update the SVLAN circuit in CTC, the circuit must be refreshed.
However, any changes made to subtended OCH trail circuits are reflected in the SVLAN circuit in CTC.
If an OCH trail becomes incomplete and the current SVLAN circuit snapshot has some SVLAN circuits
that are using it, they remain incomplete. If the snapshot contains incomplete SVLAN circuits and an
OCH trail circuit becomes available, the incomplete SVLAN circuit snapshot in CTC appears to be
complete.
When the destination port of the SVLAN circuit facing the router is configured as a NNI client port, the
outgoing ethernet packets do not drop the SVLAN tag when they exit the MSTP network allowing the
router to determine the origin of the ethernet packet.
SVLAN circuits are stateless circuits; an administrative or service state need not be set.

Note

During SVLAN provisioning, if a SVLAN circuit span using UNI ports in transparent mode is over
subscribed, a warning message is displayed. However, the circuit is created. This is supported on channel
groups on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards.
For related procedure, see:
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•

NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card SVLAN Databases,
page 17-84

•

NTP-G203 Create End-to-End SVLAN Circuits, page 17-96

17.3.1 End-to-End SVLAN Provisioning Rules
The following provisioning rules and conditions apply to end-to-end SVLAN circuits:
•

GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards must be provisioned in L2-over-DWDM mode.

•

SVLAN database must be loaded with the SVLAN.

•

SVLAN circuits are routed through OCH trail circuits or PPC; Client/Trunk to Client/Trunk (L2).
Therefore, before creating an SVLAN circuit, make sure that the subtended OCH trail circuits
between GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards or PPC links are created.

•

For protected SVLAN circuits, create a ring (through OCH trail circuits), define a master node, and
enable the protection role.

For information on how to create end-to-end SVLAN circuit, see the “NTP-G203 Create End-to-End
SVLAN Circuits” section on page 17-96 procedure.

17.3.2 Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary.

Note

The procedures and tasks described in this section for the Cisco ONS 15454 platform is applicable to the
Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.
This section lists the procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1.

NTP-G151 Create, Delete, and Manage Optical Channel Client Connections,
page 17-15—Complete as needed.

2.

NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-34—Complete as needed.

3.

NTP-G59 Create, Delete, and Manage Optical Channel Network Connections,
page 17-41—Complete as needed.

4.

NTP-G334 Configure GMPLS Optical Restoration—Complete as needed.

5.

NTP-G200 Create, Delete, and Manage STS or VC Circuits for the ADM-10G Card,
page 17-55—Complete as needed.

6.

NTP-G150 Upgrade Optical Channel Network Connections to Optical Channel Client Connections,
page 17-65—Complete as needed.

7.

NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits, page 17-69—Complete as needed to
verify all conditions are valid before placing OCHNC or OCH trail circuits in service.

8.

NTP-G58 Locate and View Optical Channel Circuits, page 17-71—Complete as needed to find,
view, and filter OCHCC, OCHNC, and OCH trail circuits.

9.

NTP-G184 Create a Provisionable Patchcord, page 17-78—Complete as needed.

10. NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card SVLAN Databases,

page 17-84—Complete as needed.
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11. NTP-G60 Create and Delete Overhead Circuits, page 17-87—Complete as needed to create

IP-encapsulated tunnels, firewall tunnels, and proxy tunnels; to create generic communications
channel (GCC) terminations; to provision orderwire; or to create user data channel (UDC) circuits.
12. NTP-G62 Create a J0 Section Trace, page 17-95—Complete as needed to monitor interruptions or

changes to traffic between two nodes.
13. NTP-G203 Create End-to-End SVLAN Circuits, page 17-96—Complete as needed to create end to

end VLAN circuits.
14. NTP-G229 Provision DCN Extension for a Network Using GCC/DCC, page 17-99—Complete as

needed to provision DCN extension for a network using GCC/DCC.

NTP-G151 Create, Delete, and Manage Optical Channel Client
Connections
Purpose

This procedure creates, deletes, and manages OCHCC circuits. The
OCHCC circuits can be created using the Circuit Creation wizard or the
GMPLS view. OCHCCs create an end-to-end optical management path
between TXP, MXP, GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE (when
provisioned as TXPs or MXPs), OTU2_XP, 100G-LC-C, 10x10G-LC,
CFP-LC, AR_MXP, AR_XP, or AR_XPE client ports, or between ITU-T
trunk ports. ITU-T line cards include: OC48 ELR/STM64 EH, OC192
SR1/STM64 IO, MRC-12, MRC-2.5-12, and MRC-2.5G-4. The OCHCC
circuit is transported by an OCH trail circuit that is associated to one or
more OCHNC circuits (for example, an OCHCC circuit passing through a
regen node).

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

This procedure is not applicable to the ADM-10G card or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards that are provisioned in L2-over-DWDM mode.

Step 1

As needed, identify the OCHCC to be provisioned using the “DLP-G350 Use the Cisco Transport
Planner Traffic Matrix Report” task on page 16-27.

Step 2

Complete the DLP-G46 Log into CTC at a node on the network where you want to manage OCHCCs. If
you are already logged in, continue with Step 3.

Step 3

If you want to assign a name to the OCHCC source and destination ports before you create the circuit,
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with Step 4.

Tip

Naming the client ports help in identifying them correctly later.
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Step 4

If the client TXP, MXP, or ITU-T line cards are installed in a multishelf node, continue with Step 5. If
not, complete the following substeps:
a.

Use the information obtained from the Cisco Transport Planner traffic matrix report in Step 1 to
complete the “DLP-G344 Verify Provisionable and Internal Patchcords” task on page 17-68. If
provisionable patchcords (PPCs) exist between the nodes containing the TXP/MXP/ITU-T line
cards and the DWDM nodes at each end of the OCHCC, continue with Step 5. If not, continue with
Step b.

b.

Complete the “NTP-G184 Create a Provisionable Patchcord” task on page 17-78 to create the PPCs
between the OCHCC source and destination nodes.

Note

For the AR_XPE card, you can specify the ODU0 and ODU1 trunk side bandwidth when a 1GE or 1GFC
payload is configured on the card.

Step 5

If the client TXP/MXP/ITU-T line cards are installed in a multishelf node, use the information obtained
from the Cisco Transport Planner traffic matrix report in Step 1 to create internal patchcords between
the 32DMX, 32DMX-O, or 32DMX-L ports and the TXP/MXP trunk ports using the “NTP-G242 Create
an Internal Patchcord Manually” task on page 14-112. Create the internal patchcords on both the source
and destination nodes of each OCHCC path. If the TXP/MXP/ITU-T line cards are not installed in a
multishelf node, continue with Step 6.

Step 6

Complete the “DLP-G345 Verify OCHCC Client Ports” task on page 17-17 to verify the port rate and
service state.

Step 7

To provision the OCHCC circuit, use either of the following procedures as needed:
•

“DLP-G346 Provision Optical Channel Client Connections” task on page 17-18

•

“DLP-G705 Provision GMPLS Optical Channel Client Connections” task on page 17-25

Step 8

Complete the “DLP-G706 Perform Optical Validation of GMPLS Circuits” task on page 17-32, as
needed.

Step 9

Complete the “DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit” task on page 17-33, as
needed.

Step 10

Complete the “DLP-G424 Edit an OCHCC Circuit Name” task on page 17-28, as needed.

Step 11

Complete the “DLP-G394 Change an OCHCC Administrative State” task on page 17-29, as needed.

Step 12

Complete the “DLP-G347 Delete Optical Channel Client Connections” task on page 17-26, as needed.
Stop. You have completed this procedure.

DLP-G104 Assign a Name to a Port
Purpose

This task assigns a name to a port on any ONS 15454 card.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher
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Step 1

In node view, double-click the card that has the port that you want to provision. This can be any port on
a traffic-carrying card. The card view opens.

Step 2

Click the Provisioning tab.

Step 3

Double-click the Port Name table cell for the port number where you are assigning a name. The cell
activates and a blinking cursor indicates where you should enter the port name.

Step 4

Enter the port name.
The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

Step 5

Click Apply.

Step 6

Return to your originating procedure (NTP).

DLP-G345 Verify OCHCC Client Ports
Purpose

This task verifies the rate and service state of the OCHCC client ports.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

In node view, double-click the TXP, MXP, OTU2_XP, AR_MXP, AR_XP, AR_XPE, or ITU-T line card
where you want to verify the client ports. The card view opens.

Step 2

Click the Provisioning > Maintenance tabs.

Step 3

Click the Provisioning > Pluggable Port Modules tabs.

Step 4

Verify that a pluggable port module has been created and that the port rate under the Pluggable Port area
is provisioned. If so, continue with Step 5. If not, complete the DLP-G726 Preprovisioning a Multirate
PPM and the “DLP-G278 Provision the Optical Line Rate” task on page 11-175.

Step 5

Repeat Steps 1 through 4 for each TXP, MXP, OTU2_XP, AR_MXP, AR_XP, AR_XPE, or ITU-T line
card containing OCHCC ports that you want to verify.

Step 6

Return to your originating procedure (NTP).
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DLP-G346 Provision Optical Channel Client Connections
Purpose

This task creates an OCHCC between two TXP, MXP, GE_XP and
GE_XPE (when configured in TXP or MXP mode), 10GE_XP and
10GE_XPE (when configured in TXP or MXP mode), OTU2_XP,
AR_MXP, AR_XP, or AR_XPE client ports, or two ITU-T-compliant line
card trunk ports.

Tools/Equipment

Cisco Transport Planner Traffic Matrix Report

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G345 Verify OCHCC Client Ports, page 17-17
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

OCHCCs can be created on preprovisioned client cards or physically installed client cards.

Note

Creating an OCHCC circuit automatically creates an OCH trail circuit between the OCHCC source and
destination client card trunk ports. The OCH trail circuit is created for the first OCHCC between two
MXP cards. The OCH trail circuit is used by succeeding OCHCCs created between the MXP cards.
When the OCH trail is created, it is assigned a system-generated name in the format
circuit-type_NE-name::unique sequence number. To edit the OCH trail circuit name, complete the
“DLP-G424 Edit an OCHCC Circuit Name” task on page 17-28.

Note

If trunk ports are connected by a peer-to-peer provisionable patchcord (PPC), an OCH trail is not created.

Note

The OCH Wlen (wavelength) parameter on the Circuits page can be used to determine the OCHCC and
OCH trail associations.

Note

If you want the OCHCC circuit to provision the client card trunk port’s ITU-T G.709, FEC, SD and SF
threshold settings and Mapping parameters, you must place the client card trunk ports out of service. If
any of the trunk ports, including OTU2-XP regen ports, are in-service state, a warning message “Trunk
settings are not applied on any of the trunk ports” is displayed with details of the trunk ports that are in
in-service state.

Note

In a node using OTU2_XP cards configured in the regen mode, a single OCHCC circuit can be created
that passes through the OTU2_XP card. Internal patch cords must be created from the OTU2_XP regen
ports to the respective add/drop cards. OCHCC circuit creation through OTU2_XP cards in regen mode
is not supported if different wavelengths are used on the two OTU2_XP regen ports.
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Note

The OCHCC circuit creation is not supported between different payloads in the 40G-MXP-C,
40E-MXP-C, and 40ME-MXP-C cards.

Note

The 40G-MXP-C card configured in the unidirectional regen mode does not support OCHCC circuit
creation. Two bidirectional OCHNC circuits can be created, one on either side of the regenerator group
for managing the circuit.

Note

In AR_MXP, AR_XP, and AR_XPE cards, you cannot create the circuits using FICON payload option
in Circuit Creation wizard. Create circuits using FC payload to bring up FICON traffic.

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab, then click Create.

Step 3

In the Circuit Creation dialog box, choose OCHCC from the Circuit Type list.

Step 4

Click Next.

Step 5

In the Circuit area of the Circuit Attributes page, provision the OCHCC circuit attributes:
•

Name—Assign a name to the OCHCC. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor
circuits. If you leave the field blank, Cisco Transport Controller (CTC) assigns a default name to the
circuit. When a circuit includes a network element with release prior to 9.60, the circuit name is
limited to 48 characters.

•

Type—(Display only) OCHCC.

•

Size—Defines the circuit payload type and rate. Two fields are provided. The first specifies the
payload type. Choose a payload type, then choose the rate in the next field. Table 17-5 provides the
OCHCC payload types and rates.

Note

The payload type and rate must match the PPM provisioning on the client cards at the source
and destination nodes.

Table 17-5

OCHCC Client Rates

Payload Type

Rates

SONET/SDH

OC-192 (ANSI)/STM-64 (ETSI)—9.92 Gbps
OC-48 (ANSI)/STM-12 (ETSI)—2.48 Gbps
OC-12 (ANSI)/STM-4 (ETSI)—622 Mbps
OC-3 (ANSI)/STM-1 (ETSI)—155 Mbps

Ethernet

10GE—One Gigabit Ethernet 11.25 Gbps
1GE—One Gigabit Ethernet 1.125 Gbps
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Table 17-5

OCHCC Client Rates (continued)

Payload Type

Rates

FC/FICON

10GFC—Fibre Channel 10 Gbps
4GFC—Fibre Channel 4 Gbps
2GFC—Fibre Channel 2.125 Gbps
1GFC—Fibre Channel 1.06 Gbps
4GFICON—FICON 4 Gbps
2GFICON—FICON 2.125 Gbps
1GFICON—FICON 1.06 Gbps

Data Storage

ESCON—Enterprise System Connection 200 Mbps (IBM signal)
ISC Peer—Inter System Coupling Link 3 (ISC3)
ISC3 Peer 1G—InterSystem Coupling Link 3 (ISC3) 1 Gbps
ISC3 Peer 2G—InterSystem Coupling Link 3 (ISC3) 2 Gbps
ISC COMPAT—InterSystem Coupling Link 1 (ISC1)
ISC1—Inter system connect Link 1 (ISC1)

Video

HDTV—High Definition Television
SDI/DI—Serial Digital Interface and Digital Video signal type 1
DV6000—Proprietary signal from video vendor
DVB-ASI—Proprietary signal from video vendor

Other
•

Pass Through—Creates a pass-through OCHCC

OCHNC Wavelength—Provides three fields to define the wavelength that the OCHCC will use to
travel across the OCH network. Choose a wavelength from the first field. In the second field, you
can change the wavelength band by choosing either C Band or L Band. In the third field, you can
indicate whether odd or even C-band or L-band wavelengths appear. See Table 17-6 and Table 17-7
for C-band and L-band wavelengths.

Note

Table 17-6

The OCHNC wavelength must match the trunk wavelength provisioned on the source and
destination TXP or MXP cards. If the wavelengths do not match, the card will not appear as
a source or destination.
OCH C-Band Channels

Channel No. Channel ID

Frequency (GHz)

Wavelength (nm)

1

30.3

195.9

1530.33

2

31.1

195.8

1531.12

3

31.9

195.7

1531.90

4

33.4

195.5

1532.68

5

32.6

195.6

1533.471

6

34.2

195.4

1534.25
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Table 17-6

OCH C-Band Channels (continued)

Channel No. Channel ID

Frequency (GHz)

Wavelength (nm)

7

35.0

195.3

1535.04

8

35.8

195.2

1535.82

9

36.1

195.1

1536.61

10

37.4

195

1537.401

11

38.1

194.9

1538.19

12

38.9

194.8

1538.98

13

39.7

194.7

1539.77

14

40.5

194.6

1540.56

15

41.3

194.5

1541.351

16

42.1

194.4

1542.14

17

42.9

194.3

1542.94

18

43.7

194.2

1543.73

19

44.5

194.1

1544.53

20

44.3

194

1545.321

21

46.1

193.9

1546.12

22

46.9

193.8

1546.92

23

47.7

193.7

1547.72

24

48.5

193.6

1548.51

25

49.3

193.5

1549.321

26

50.1

193.4

1550.12

27

50.9

193.3

1550.92

28

51.7

193.2

1551.72

29

52.5

193.1

1552.52

30

53.3

193

1553.331

31

54.1

192.9

1554.13

32

54.9

192.8

1544.94

33

55.7

192.7

1555.75

34

56.5

192.6

1556.55

35

57.3

192.5

1557.361

36

58.1

192.4

1558.17

37

58.9

192.3

1558.98

38

59.7

192.2

1559.79

39

60.6

192.1

1560.61

40

61.3

192

1561.421

1. Requires 40-channel MUX or WSS cards, and 40-channel DMX cards.
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Table 17-7

OCH L-Band Channels

Channel
Number

Frequency
(THz)

Wavelength
(nm)

Channel
Number

Frequency
(THz)

Wavelength
(nm)

1

190.85

1570.83

41

188.85

1587.46

2

190.8

1571.24

42

188.8

1587.88

3

190.75

1571.65

43

188.75

1588.30

4

190.7

1572.06

44

188.7

1588.73

5

190.65

1572.48

45

188.65

1589.15

6

190.6

1572.89

46

188.6

1589.57

7

190.55

1573.30

47

188.55

1589.99

8

190.5

1573.71

48

188.5

1590.41

9

190.45

1574.13

49

188.45

1590.83

10

190.4

1574.54

50

188.4

1591.26

11

190.35

1574.95

51

188.35

1591.68

12

190.3

1575.37

52

188.3

1592.10

13

190.25

1575.78

53

188.25

1592.52

14

190.2

1576.20

54

188.2

1592.95

15

190.15

1576.61

55

188.15

1593.37

16

190.1

1577.03

56

188.1

1593.79

17

190.05

1577.44

57

188.05

1594.22

18

190

1577.86

58

188

1594.64

19

189.95

1578.27

59

187.95

1595.06

20

189.9

1578.69

60

187.9

1595.49

21

189.85

1579.10

61

187.85

1595.91

22

189.8

1579.52

62

187.8

1596.34

23

189.75

1579.93

63

187.75

1596.76

24

189.7

1580.35

64

187.7

1597.19

25

189.65

1580.77

65

187.65

1597.62

26

189.6

1581.18

66

187.6

1598.04

27

189.55

1581.60

67

187.55

1598.47

28

189.5

1582.02

68

187.5

1598.89

29

189.45

1582.44

69

187.45

1599.32

30

189.4

1582.85

70

187.4

1599.75

31

189.35

1583.27

71

187.35

1600.17

32

189.3

1583.69

72

187.3

1600.60

33

189.25

1584.11

73

187.25

1601.03

34

189.2

1584.53

74

187.2

1601.46

35

189.15

1584.95

75

187.15

1601.88
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Table 17-7

Step 6

OCH L-Band Channels (continued)

Channel
Number

Frequency
(THz)

Wavelength
(nm)

Channel
Number

Frequency
(THz)

Wavelength
(nm)

36

189.1

1585.36

76

187.1

1602.31

37

189.05

1585.78

77

187.05

1602.74

38

189

1586.20

78

187

1603.17

39

188.95

1586.62

79

186.95

1603.60

40

188.9

1587.04

80

186.9

1604.03

•

Bidirectional—(Display only) OCHCCs are bidirectional. This field cannot be changed.

•

Protection—Check to create a splitter-protected OCHCC (only MXPP/TXPP cards will be
selectable as circuit endpoints) or a protected OCHCC when TXP is connected to a PSM card.

In the State area of the Circuit Attributes page, provision the OCHCC state attributes:
•

State—Provisions the OCHCC circuit state. The state can be IS (ANSI)/Unlocked (ETSI) or
OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

•

Apply to OCHCC ports—If checked, applies the state chosen in the Apply to OCHCC ports
drop-down list to the OCHCC client ports. For TXP, MXP, TXPP, or MXPP cards, the administrative
state will apply to the client and all trunk ports. For ITU-T-compliant line cards, the administrative
state will apply to the trunk port only. The states that you can apply include:
IS (ANSI)/Unlocked (ETSI), OOS,DSBLD (ANSI)/Locked,Disabled (ETSI), and
IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI).

Step 7

Click Next.

Step 8

In the Source area, choose the source node from the Node drop-down list, then choose the source shelf
(multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, and,
if needed, the source port from the Port drop-down list.
If no nodes appear in the Node drop-down list, complete the following steps:
a.

Click Back and review your circuit attribute settings. Verify that they are set to the client attributes
provisioned on the client cards. If necessary, click Cancel and complete the “DLP-G345 Verify
OCHCC Client Ports” task on page 17-17 to verify the client settings.

b.

If the source and/or destination nodes are not configured for multishelf, complete the “DLP-G344
Verify Provisionable and Internal Patchcords” task on page 17-68 to verify that the patchcords were
created accurately.

If these steps do not solve the problem, refer to your next level of support.
Step 9

Click Next.

Step 10

In the Destination area, choose the destination node from the Node drop-down list, then choose the
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot
drop-down list, and, if needed, the destination port from the Port drop-down list.
If no nodes appear in the Node drop-down list, complete the following steps:
a.

Click Back and review your circuit attribute settings. Verify that they are set to the client attributes
provisioned on the client cards. If necessary, click Cancel and complete the “DLP-G345 Verify
OCHCC Client Ports” task on page 17-17 to verify the client settings.
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b.

If the source and/or destination nodes are not configured for multishelf, complete the “DLP-G344
Verify Provisionable and Internal Patchcords” task on page 17-68 to verify that the patchcords were
created accurately.

If these steps do not solve the problem, refer to your next level of support.
Step 11

Click Next. If the OCHCC is between ITU-T cards, continue with Step 12. If not, skip to Step 14.

Step 12

Complete the “DLP-G437 Set OCH Circuit Attributes” task on page 17-29.

Step 13

Click Next.

Step 14

Complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31. Skip this step and
continue with Step 16 if no constraints are needed. If the trunk ports are already connected by an existing
OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in
read-only mode; all buttons are disabled. Continue with Step 16.

Step 15

If the circuit is being created for AR_MXP, AR_XP, or AR_XPE card with MXP_MR (low or high rate)
or MXPP_MR (low or high rate) operating mode, select the ODU1 and the respective timeslot within the
selected ODU1. Table 17-8 describes the bandwidth utilization for the selected payload.

Note

For the all other cards/card modes, you cannot select the ODU1 and timeslot parameters.
Table 17-8

Bandwidth Utilization for the Selected Payload

Payload

Number of ODU1s
required

Number of ODU0s
required

Number of
Timeslot
required/ODU1

OC3

1

—

1

OC12

1

—

4

OC48

1

—

16

FC2

1

—

14

ESCON

1

—

2

GE

1

1

NA

FC1

1

NA

ISC3-1G

—

FE

ISC3-2G

FC4G
Step 16

2

—

NA

Click Finish. The OCHCC and its OCH trail appear in the Circuits page. After the circuit status has been
verified, the DISCOVERED status appears in the Status column.
If the OCHCC status does not change to DISCOVERED within 2 to 3 minutes, contact your next level
of support.

Step 17

Return to your originating procedure (NTP).
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DLP-G705 Provision GMPLS Optical Channel Client Connections
Purpose

This task creates an OCHCC circuit between two TXP, MXP, GE_XP and
GE_XPE (when configured in TXP or MXP mode), 10GE_XP and
10GE_XPE (when configured in TXP or MXP mode), or OTU2_XP client
ports, or two ITU-T-compliant line card trunk ports.

Tools/Equipment

Cisco Transport Planner Traffic Matrix Report

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G345 Verify OCHCC Client Ports, page 17-17

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

You cannot directly create the GMPLS OCHCC circuit on the 100G-LC-C, 10x10G-LC, and CFP-LC
cards when configured in MXP-10x10G (10x10G Muxponder) card mode or with AR-XP cards. There
are two ways to create the GMPLS OCHCC circuit:
•

Create the GMPLS OCH trail and then create the OCHCC circuit.

•

Create the OCHCC circuit and then upgrade the circuit to GMPLS OCHCC circuit.

Note

You cannot create GMPLS OCHCC circuit on the AR_XP, AR_MXP, and AR_XPE cards directly from
the NFV view.

Step 1

From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV view
opens.

Step 2

From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 3

In the Circuit Parameters pane, provision the OCHCC circuit attributes:
a.

Name—Assign a name to the circuit. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). When a circuit includes a network element with release prior to 9.60, the circuit name is
limited to 48 characters.

b.

Type—Choose OCHCC.

c.

Protected—Check to route the circuit on a protected path. Select the protection type from the
drop-down list. The available options are:
– PSM—When a PSM card is connected to a TXP card.
– Y-CABLE—The circuit is protected by a transponder or muxponder card in a Y-cable protection

group.
– Splitter—When a MXPP/TXPP card is used. The circuit source and destination are on

MXPP_MR_2.5G and TXPP_MR_2.5G cards. These cards provides splitter (line-level)
protection.
d.

IS—Check to place the trunk ports of the TXP /MXP card in service.
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Step 4

e.

OCHNC Wavelength—Provides three fields to define the wavelength for the OCHCC circuit.
Choose a wavelength from the first field. The wavelength band in the second field is set to C Band.
In the third field, indicate whether odd or even C-band wavelengths appear. Table 17-6 lists the
C-band wavelengths.

f.

Protected OCHNC Wavelength—Define the wavelength of the protected OCHCC circuit. This field
is visible only when the Protected check box is checked in Step c. The options available are similar
to that of OCHNC Wavelength.

g.

Validation—Set the validation mode. For more information about the validation modes, see the
“12.10.1.3 Validation Modes” section on page 12-110.

h.

Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit
is created if the actual optical validation result is greater than or equal to the value set in this field.
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance
Thresholds” section on page 12-110.

i.

Protection Acceptance Threshold—Sets the optical validation threshold value for the protected
GMPLS circuit.

Configure the source and destination ports at the circuit endpoints in the map. For more information
about configuring the source and destination ports, see the “12.10.3.3 Source and Destination Port
Configuration” section on page 12-119.

Note

The OCHCC circuit endpoints must be selected on the TXP/MXP cards. If other ports are
selected, a warning dialog box is displayed prompting you to change the circuit type.

Step 5

Define the working or protect port parameters. For more information, see the “12.10.3.3.1 Working and
Protect Port Parameters” section on page 12-120. Click Apply in the Working Port Parameters pane and
Protected Port Parameters pane, to apply the settings.

Step 6

Click Apply in the Circuit Parameters pane.

Step 7

Click Yes in the Create Circuits confirmation dialog box.
The OCHCC and its OCH trail appear in the Circuits tab in the Network Data pane. After the circuit
status has been verified, the DISCOVERED status appears in the Status column. The circuit might take
a few minutes to come up, depending on the size of the network.

Step 8

Return to your originating procedure (NTP).

DLP-G347 Delete Optical Channel Client Connections
Purpose

This task deletes DWDM OCHCC circuits.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher
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Note

If you are deleting more than half of all the active OCHCCs, it is recommended that you delete them two
at a time to allow for proper power compensation. You do not need to delete the active OCHCCs two at
a time if you are deleting all them.

Step 1

Complete the “NTP-G103 Back Up the Database” task on page 24-2 to preserve existing settings and, if
you want to recreate the circuits, record the circuit information.

Step 2

Consult your network operations center (NOC) or other appropriate personnel to verify that the OCHCC
can be safely deleted.

Step 3

Investigate all network alarms and resolve any problems that might be affected by the OCHCC deletion.

Step 4

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 5

Under the Type column, choose one or more OCHCCs that you want to delete, then click Delete.

Step 6

In the Delete Circuits confirmation dialog box, complete the following:
•

Change drop port admin state—Check this box if you want to change the circuit source and
destination port administrative state. After checking the box, choose one of the following
administrative states:
– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.
– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in

service.
– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and

disables them.
– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for

maintenance.
•

Notify when completed—Checked this box if you want the CTC Alerts confirmation dialog box to
notify you when the OCHCC is deleted. During this time, you cannot perform other CTC functions.
If you are deleting many OCHCCs, waiting for confirmation might take a few minutes. Circuits are
deleted whether or not this check box is checked.

Note

The CTC Alerts dialog box will not automatically open to show a deletion error unless you
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information,
see the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC
Alerts dialog box is not set to open automatically, the red triangle inside the CTC Alerts
toolbar icon indicates that a notification exists.

Step 7

(For AR_MXP, AR_XP, and AR_XPE cards) An OCHCC circuit cannot be deleted when the associated
client port on the card is in IS (ANSI) or Unlocked (ETSI) state. To delete an OCHCC circuit, move the
associated client port to OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state and then delete the
OCHCC circuit.

Step 8

Complete either of the following:
•

If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

•

If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.
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Step 9

If you want to save the information in the CTC Alerts dialog box, complete the following substeps. If
you do not want to save it, continue with Step 10.
a.

Click Save.

b.

Click Browse and navigate to the directory where you want to save the file.

c.

Type the file name using a TXT file extension, and click OK.

Step 10

Click Close to close the CTC Alerts dialog box.

Step 11

Complete the “NTP-G103 Back Up the Database” task on page 24-2 if you require a backup of your
changes.

Step 12

Return to your originating procedure (NTP).

DLP-G424 Edit an OCHCC Circuit Name
Purpose

This task changes the name of an OCHCC circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45
DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

To rename the OCHCC circuit, do either of the following.
•

Network view—Select the OCHCC circuit in the Circuits tab and click Edit.

•

NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3

In the Edit Circuit dialog box, click the General tab.

Step 4

In the Name field, enter the new OCHCC circuit name.

Step 5

Click Apply.

Step 6

Return to your originating procedure (NTP).
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DLP-G394 Change an OCHCC Administrative State
Purpose

This task changes the administrative state of an OCHCC circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G346 Provision Optical Channel Client Connections, page 17-18
DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

To change the administrative state of the OCHCC circuit, do either of the following.
•

Network view—Select the OCHCC circuit in the Circuits tab and click Edit.

•

NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3

In the Edit Circuit dialog box, click the State tab.

Step 4

Click the cell in the Admin State column for the card you want to change, and choose an administrative
state from the drop-down list:
•

IS (ANSI) or Unlocked (ETSI)

•

OOS (ANSI) or Locked (ETSI)

Step 5

Click Apply.

Step 6

If you are changing the OCHCC state to OOS/Locked, click OK in the confirmation dialog box. (No
confirmation dialog box appears when placing OCHCCs in service.)

Note

Step 7

For information about the OCH circuit state transitions, see the Administrative and Service States
document.
Return to your originating procedure (NTP).

DLP-G437 Set OCH Circuit Attributes
Purpose

This task provisions OCH trunk attributes.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
The OCH Circuit Attributes page must be open.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher
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Step 1

In the OCH Circuit Attributes Preferences page, change the trunk settings as necessary. The settings
provisioned here can only be provisioned on the ports when the ports are out of service. If the ports are
in service, these parameters must be the same as the source and destination card ports. If not, the trunk
settings are not editable and are retained as they are on both the trunk ports. An information pop up
window is shown after the circuit creation indicating that the trunk settings are not applied on any of the
trunk ports. You can view the current trunk settings (display only) in the Current Values area.
•

To change any of the trunk settings, complete the following in the Provisioning Values area:
– ITU-T G.709 OTN—Choose Enable or Disable to set or disable the IEEE G.709 monitoring on

the optical transport network. If the OCHCC source or destination is an TXP_MR_10EX_C,
40E-TXP-C, 40ME-TXP-C, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L,
MXP_2.5G_10EX_C, MXP_MR_10DMEX_C, 40G-MXP-C, 40E-MXP-C, or 40ME-MXP-C
card, the ITU-T G.709 OTN parameter must always be checked. If ITU-T G.709 OTN is
checked, the MXP_MR_2.5G and MXPP_MR_2.5G cards will not appear as OCHCC source
and destination options.
– FEC—Choose the type of FEC: Disabled, Standard, or Enhanced. The options that appear

depend on the card type. If the OCHCC source or destination is an TXP_MR_10EX_C,
MXP_2.5G_10EX_C, MXP_MR_10DMEX_C, 40G-MXP-C, 40E-MXP-C, 40ME-MXP-C,
40E-TXP-C, or 40ME-TXP-C card, the ITU-T G.709 OTN parameter must always be checked.
– SD BER—Choose the signal degrade bit error rate. The range of SD BER values supported for

Cisco 7600 router is from 5 to 9.
– (Cisco 7600 series routers only) OPU—Choose the ITU-T G.709 OPU standard. OPU-1E and

OPU-2E standards are supported on the Cisco 7600 series routers.
– SF BER—Choose the signal fail bit error rate.
– Mapping—Sets the mapping for the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,

TXP_MR_10EX_C, MXP_MR_10DME_C, MXP_MR_DME_L, and MXP_MR_10DMEX_C
cards: Not Used, ODU Multiplex (client SONET/SDH payload), Asynchronous, or
Synchronous. The choices available depend on the card. If you set mapping to Synchronous,
the client signal is mapped into the OTU2 signal without justification of the payload because
the client signal timing (the timing source) is the same as the trunk output timing. If you set
mapping to Asynchronous, the trunk timing is disconnected from the client timing (because the
network element [NE] is the timing source), so justification is needed to map the client signal
(OC192/STM64) to OTU2 trunk output.

Note

When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous
options. A 4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is
necessary to provision a 4xOC-48 OCHCC circuit.

Note

If the OCHCC source or destination is an MXP_2.5G_10E, MXP_2.5G_10E_C,
MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card, the Mapping parameter must always be set to
Synch.

Set the proactive protection attributes. Proactive Protection Regen is supported on OTU2XP ports alone
in Standard Regen and Enhanced FEC mode

Note

Proactive protection regen is supported only on CRS-based OCH trails.

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

17-30

78-20702-02

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords
DLP- G438 Set OCH Routing Preferences

•

Proactive Protection—Choose Enable or Disable.

•

Trigger Threshold—Choose the minimum BER threshold to trigger proactive protection by sending
forward defect indication (FDI).

•

Trigger Window—The trigger window value must be in multiples of 10 ms for trigger thresholds
between 1E-3 and 6E-6 or 100 ms for trigger threshold between 5E-6 to 1E-7. Enter the duration to
monitor the BER before triggering the proactive protection. The trigger window must be less than
or equal to 10000 ms.

•

Revert Threshold—Choose a BER value, to indicate the threshold at which the FDI is cleared to
allow traffic.

•

Revert Window—Enter the duration to monitor the BER for which it should be less than the revert
threshold value before removing the FDI sent to the router.
The revert window must be less than or equal to 10000ms. The revert window value must be at least
2000ms and in multiples of 10ms for a Revert Threshold of 1E-4 to 6E-7, or 100ms for a Revert
Threshold of 5E-7 to 5E-8.

•

Set the protection in the Protection area, as needed. The fields in the protection area are disabled if
the OCHCC is not protected and for OCH Trails. Set the following attributes:
– Revertive—If checked, traffic reverts to the working card after failure conditions remain

corrected for the amount of time entered in the Reversion Time field.
– Reversion Time—Sets the reversion time when Revertive is checked. The range is 0.5 to 12.0

minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse before
the traffic reverts to the working card after conditions causing the switch are cleared.
Step 2

Return to your originating procedure (NTP).

DLP-G438 Set OCH Routing Preferences
Purpose

This task provisions OCH routing preferences.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
The OCH Circuit Routing Preferences page must be open.

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

In the OCH Circuit Routing Preferences page, view the circuit route. The new OCH appears with blue
span arrows. Moving your cursor over the arrow displays span information including source, destination,
and span loss. Complete the following steps to manually provision the routing constraints.
a.

In the circuit map area, click a node that you want to include or exclude from the circuit route.

b.

Click Include or Exclude. The node name will appear under the Included nodes or Excluded nodes
list. Include and Exclude cannot be applied to source or destination nodes.

c.

Repeat Steps a and b until the circuit routing constraints are complete. To remove a node from the
Included nodes or Excluded nodes list, click the node in the list and click Remove. To move a node
up or down in the routing sequence, click the node in the list and click Up or Down.
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Note
d.

Use the Reset button as needed to clear the constraints and set the default routing.

To force the circuit route through specific links, click Advanced. Select the sides where the circuit
must cross this node and click OK:
– No Side Constraints—Uncheck.
– Side In—Choose the first side from the drop-down list.
– Side Out—Choose the second side from the drop-down list.

Note

Step 2

All forced links appear in yellow.

e.

Click Apply. CTC verifies the circuit route. If the route is valid, a “Routing evaluation succeeded.”
message appears. If this message appears, click OK. If the route is not valid, a Route Error dialog
box appears with an error message. If an error message appears, evaluate the error, click Close to
close the error dialog box and repeat Steps a through e until the circuit route is successfully
validated.

f.

If the OCHCC is protected, repeat Steps a through e for the protect trunk ports.

Return to your originating procedure (NTP).

DLP-G706 Perform Optical Validation of GMPLS Circuits
Purpose

This task performs revalidation of a GMPLS circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

Select the GMPLS circuit to be re-validated and click Opt Val. The optical validation is performed and
its result is displayed in a pop-up window.

Step 3

Return to your originating procedure (NTP).
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DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit
Purpose

This task upgrades a non-GMPLS circuit to a GMPLS circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

If the non-GMPLS circuit was provisioned in a release older than R9.40, ensure that fiber attributes are
available in the Provisioning > WDM-ANS -> GMPLS/WSON -> Fiber Attributes tab. For more
information about the Fiber Attributes tab, see the “12.10.3.5 Fiber Attributes and Alien Wavelength
Provisioning” section on page 12-121.
If the Fiber Attributes tab is empty, import the latest Cisco Transport Planner NE Update configuration
file as described in the “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File”
task on page 14-48.

Step 2

Define the Alien Wavelength parameters in the Provisioning > WDM-ANS -> GMPLS/WSON ->
Alien Wavelength tab if one of the following conditions exist. If not, continue with Step 3.
•

In the non-GMPLS circuit, the TXP or MXP or ITU-T line cards are connected to the add/drop
DWDM ports with provisionable patchcords (PPCs).

•

No internal patchcords exist between the TXP/MXP and the add/drop DWDM ports (for example,
in the case of a CRS connected to the add/drop DWDM ports).

For more information about the Alien Wavelength tab, see the “12.10.3.5 Fiber Attributes and Alien
Wavelength Provisioning” section on page 12-121.
Step 3

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 4

Select the circuit to be upgraded and click WSON Upgrade.

Note

The WSON Upgrade option is available only when a non-GMPLS circuit is selected.

Step 5

Click Yes in the Upgrade Circuits confirmation dialog box. The WSON/GMPLS Circuit Promotion
dialog box is displayed.

Step 6

From the Validation drop-down list, choose the validation mode. For more information about the
validation modes, see the “12.10.1.3 Validation Modes” section on page 12-110.

Step 7

From the Promotion Validation degree drop-down list, choose the optical validation value. For more
information about the acceptance threshold value, see the “12.10.1.2 Acceptance Thresholds” section
on page 12-110.

Step 8

Return to your originating procedure (NTP).
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NTP-G178 Create, Delete, and Manage Optical Channel Trails
Purpose

This procedure creates and deletes DWDM OCH trail circuits and changes
their administrative states. The OCH trail circuits can be created using the
Circuit Creation wizard or the GMPLS view.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the DLP-G46 Log into CTC at a node on the network where you want to manage OCHNCs.
If you are already logged in, continue with Step 2.

Step 2

If you want to assign a name to the OCHNC source and destination ports before you create the circuit,
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with the next
step.

Step 3

Complete either of the following procedures as needed, between ADM-10G cards or GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards that are provisioned in L2-over-DWDM mode:
•

“DLP-G395 Create an Optical Channel Trail” task on page 17-35

•

“DLP-G708 Create a GMPLS Optical Channel Trail” task on page 17-37

Step 4

Complete the “DLP-G706 Perform Optical Validation of GMPLS Circuits” task on page 17-32, as
needed.

Step 5

Complete the “DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit” task on page 17-33, as
needed.

Step 6

Complete the “DLP-G710 Reroute Wavelength of GMPLS Circuits” task on page 17-54, as needed.

Step 7

Complete the “DLP-G425 Edit an OCH Trail Circuit Name” task on page 17-40, as needed.

Step 8

Complete the “DLP-G419 Change an OCH Trail Administrative State” task on page 17-40, as needed.

Step 9

Complete the “DLP-G418 Delete an Optical Channel Trail” task on page 17-38, as needed.
Stop. You have completed this procedure.
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DLP-G395 Create an Optical Channel Trail
Purpose

This task creates an OCH trail circuit between ADM-10G cards, CRS-1
routers, or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards when
provisioned in L2-over-DWDM mode.
For OCH trails connecting ADM-10G cards, the OCH trail provides the
low-layer path to route STS or VC circuits over ADM-10G cards.
For OCH trails connecting GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards in L2-over-DWDM mode, the OCH trail provides the links
associated to the SVLAN entities.
For OCH trails connecting CRS-1 or Cisco 7600 routers, the OCH trail
provides end-to-end circuit connectivity between the CRS-1 or Cisco 7600
routers passing through an MSTP network.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

OCH trail circuits are created automatically when you provision OCHCC circuits between TXP and
MXP cards.

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab, then click Create. The Circuit Creation wizard is displayed.

Step 3

In the Circuit Creation wizard, choose OCHTRAIL from the Circuit Type list.

Step 4

Click Next.

Step 5

In the Circuit area of the Circuit Attributes page, provision the OCH trail circuit attributes:
•

Name—Assign a name to the OCH trail. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor
circuits. If you leave the field blank, CTC assigns a default name to the circuit. When a circuit
includes a network element with release prior to 9.60, the circuit name is limited to 48 characters.

•

Type—(Display only) Displays the OCH trail type—OCHTRAIL.

•

Size—(Display only) Equipped non specific is the default.

•

OCHNC Wavelength—Choose a band (either C Band or L Band) in the lower drop-down list. Then,
choose the OCHNC wavelength that you want to assign to the OCH trail circuit in the upper
drop-down list. See Table 17-6 on page 17-20 and Table 17-7 on page 17-22 for C-band and L-band
wavelengths.

•

Bidirectional—This parameter does not apply to OCH trail circuits.

•

State—Provision the OCH trail circuit state. The state can be IS,AINS
(ANSI)/Unlocked automatic inservice (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).
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•

Apply to trunk ports—Check this box if you want to provision the administrative state of the OCH
trail trunk ports. If checked, choose the state in the next field, either IS (ANSI)/Unlocked (ETSI) or
OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

Step 6

Click Next.

Step 7

In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list,
and, if needed, the source port from the Port drop-down list. For most cards, the port will be
automatically chosen.
If you are creating an OCH trail circuit between CRS-1 or Cisco 7600 routers, choose the source CRS-1
or Cisco 7600 router from the Node drop-down list. The Shelf, Slot, and Port fields are not available.
CTC automatically selects the PLIM port depending on the OCHNC Wavelength value specified in
Step 5.
The source In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 8

Click Next.

Step 9

In the Circuit Destination area, choose the destination node from the Node drop-down list (only the
source node will be available because the source and destination nodes are the same), then choose the
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot
drop-down list, and, if needed, the destination port from Port drop-down list.
If you are creating an OCH trail circuit between CRS-1 or Cisco 7600 routers, choose the destination
CRS-1 or Cisco 7600 router from the Node drop-down list. The Shelf, Slot, and Port fields are not
available. CTC automatically selects the PLIM port depending on the OCHNC Wavelength value
specified in Step 5.
The destination In and Out shelf (multishelf only), slot, and port appear under the OTS Lines area to
show the destination in and out shelf, slots, and ports.

Step 10

Click Next.

Step 11

Complete the “DLP-G437 Set OCH Circuit Attributes” task on page 17-29.

Step 12

Click Next.

Step 13

Complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31. Skip this step and
continue with Step 14 if no constraints are needed. If the trunk ports are already connected by an existing
OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in
read-only mode; all buttons are disabled. Continue with Step 14.

Step 14

Click Finish. The Create Circuit wizard closes and the OCH trail circuit appears in the Circuits table
with a DISCOVERED status in the Status column. (The circuit might take a few minutes to come up,
depending on the size of the network.)

Step 15

Return to your originating procedure (NTP).
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DLP-G708 Create a GMPLS Optical Channel Trail
Purpose

This task creates a GMPLS OCH trail circuit between ADM-10G cards,
CRS-1 routers, or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards
when provisioned in L2-over-DWDM mode.
For OCH trails connecting ADM-10G cards, the OCH trail provides the
low-layer path to route STS or VC circuits over ADM-10G cards.
For OCH trails connecting GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards in L2-over-DWDM mode, the OCH trail provides the links
associated to the SVLAN entities.
For OCH trails connecting CRS-1 routers, the OCH trail provides
end-to-end circuit connectivity between the CRS-1 routers passing through
an MSTP network.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

OCH trail circuits are created automatically when you provision OCHCC circuits between TXP and
MXP cards.

Step 1

From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV View
opens.

Step 2

From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 3

In the Circuit Parameters pane, provision the OCH Trail circuit attributes:
a.

Name—Assign a name to the circuit. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). When a circuit includes a network element with release prior to 9.60, the circuit name is
limited to 48 characters.

b.

Type—Choose OCHTrail.

c.

Bidirectional—This parameter does not apply to OCH trail circuits.

d.

Protected—This parameter does not apply to OCH trail circuits.

e.

IS—Check to place the trunk ports of the TXP /MXP card in service.

f.

OCHNC Wavelength—Provides three fields to define the wavelength for the OCHCC circuit.
Choose a wavelength from the first field. In the second field, change the wavelength band by
choosing C Band. In the third field, indicate whether odd or even C-band wavelengths appear.
Table 17-6 lists the C-band wavelengths.

g.

Validation—Set the validation mode. For more information about the validation modes, see the
“12.10.1.3 Validation Modes” section on page 12-110.

h.

Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit
is created if the actual optical validation result is greater than or equal to the value set in this field.
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance
Thresholds” section on page 12-110.
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i.

Ignore Path Alarms—Check this check box to ignore the alarms on the path and create the circuit.
This parameter is used to verify whether the circuit can be created on the path.

Step 4

Configure the restoration parameters for the OCH trail circuit in the GMPLS/WSON Restoration
Configuration pane. For more information about configuring the restoration parameters, see the
12.10.3.6 GMPLS Restoration Configuration, page 12-122.

Step 5

Configure the source and destination ports at the circuit endpoints in the map. For more information
about configuring the source and destination ports, see the “12.10.3.3 Source and Destination Port
Configuration” section on page 12-119.

Step 6

Define the working or protect port parameters. For more information, see the “12.10.3.3.1 Working and
Protect Port Parameters” section on page 12-120. Click Apply in the Working Port Parameters pane and
Protected Port Parameters pane, to apply the settings.

Step 7

Click Apply in the Circuit Parameters pane.

Step 8

Click Yes in the Create Circuits confirmation dialog box.
The OCH trail appear in the Circuits tab in the Network Data pane. After the circuit status has been
verified, the DISCOVERED status appears in the Status column. The circuit might take a few minutes
to come up, depending on the size of the network.

Step 9

Return to your originating procedure (NTP).

DLP-G418 Delete an Optical Channel Trail
Purpose

This task deletes DWDM OCH trail circuits.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

If you are deleting more than half of all the active OCH trails, it is recommended that you delete them
two at a time to allow for proper power compensation. You do not need to delete the active OCH trails
two at a time if you are deleting all of them.

Step 1

Complete the “NTP-G103 Back Up the Database” task on page 24-2 to preserve existing settings and, if
you want to recreate the circuits, record the circuit information.

Step 2

Consult your network operations center (NOC) or other appropriate personnel to verify that the OCH
trail can be safely deleted.

Step 3

Investigate all network alarms and resolve any problems that might be affected by the OCH trail deletion.

Step 4

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 5

Under the Type column, choose one or more OCH trails that you want to delete, then click Delete.

Step 6

In the Delete Circuits confirmation dialog box, complete the following:
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•

Change drop port admin state—Check this box if you want to change the administrative state for the
circuit source and destination ports. After checking the box, choose one of the following
administrative states:
– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.
– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in

service.
– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and

disables them.
– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for

maintenance.
•

Note

Step 7

Step 8

Notify when completed—Check this box if you want the CTC Alerts confirmation dialog box to
notify you when the OCH trail is deleted. During this time, you cannot perform other CTC functions.
If you are deleting many OCH trails, waiting for confirmation might take a few minutes. Circuits are
deleted whether or not this check box is checked.

The CTC Alerts dialog box will not automatically open to show a deletion error unless you
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see
the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC Alerts
dialog box is not set to open automatically with a notification, the red triangle inside the CTC
Alerts toolbar icon indicates that a notification exists.

Complete either of the following:
•

If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the
information, continue with Step 8. If you do not want to save the information, continue with Step 9.

•

If you did not check Notify when completed, the Circuits page appears. Continue with Step 10.

If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you
do not want to save it, continue with Step 10.
a.

Click Save.

b.

Click Browse and navigate to the directory where you want to save the file.

c.

Type the file name using a TXT file extension, and click OK.

Step 9

Click Close to close the CTC Alerts dialog box.

Step 10

Complete the “NTP-G103 Back Up the Database” task on page 24-2 if you require a backup of your
changes.

Step 11

Return to your originating procedure (NTP).
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DLP-G425 Edit an OCH Trail Circuit Name
Purpose

This task changes the name of an OCH trail circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45
DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

To rename the OCH trail circuit, do either of the following.
•

Network view—Select the OCHCC circuit in the Circuits tab and click Edit.

•

NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3

In the Edit Circuit dialog box, click the General tab.

Step 4

In the Name field, enter the new OCH trail circuit name.

Step 5

Click Apply.

Step 6

Return to your originating procedure (NTP).

DLP-G419 Change an OCH Trail Administrative State
Purpose

This task changes the administrative state of an OCH trail circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G395 Create an Optical Channel Trail, page 17-35
DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

To change the administrative state of the OCH trail circuit, do either of the following.
•

Network view—Select the OCHCC circuit in the Circuits tab and click Edit.

•

NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3

In the Edit Circuit dialog box, click the State tab.

Step 4

Click the cell in the Admin State column for the card you want to change, and choose an administrative
state from the drop-down list:
•

IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

•

OOS,DSBLD (ANSI) or Locked (ETSI)
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Step 5

Click Apply.

Step 6

If you are changing the OCH trail state to OOS/Locked, click OK in the confirmation dialog box. (No
confirmation dialog box appears when you place OCH trails in service.)
For information about the OCH circuit state transitions, see the Administrative and Service States
document.

Step 7

Return to your originating procedure (NTP).

NTP-G59 Create, Delete, and Manage Optical Channel Network
Connections
Purpose

This procedure creates and deletes DWDM OCHNC channels and changes
their administrative states. The OCHNC circuits can be created using the
Circuit Creation wizard or the GMPLS view.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the DLP-G46 Log into CTC at a node on the network where you want to manage OCHNCs.
If you are already logged in, continue with Step 2.

Step 2

To provision an OCHNC circuit, use either of the following procedures as needed:
•

“DLP-G105 Provision Optical Channel Network Connections” task on page 17-45

•

“DLP-G709 Provision GMPLS Optical Channel Network Connections” task on page 17-47

Step 3

Complete the “DLP-G493 Provision Protected Optical Channel Network Connections” task on
page 17-49, as needed.

Step 4

Complete the “DLP-G706 Perform Optical Validation of GMPLS Circuits” task on page 17-32, as
needed.

Step 5

Complete the “DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit” task on page 17-33, as
needed.

Step 6

Complete the “DLP-G710 Reroute Wavelength of GMPLS Circuits” task on page 17-54, as needed.

Step 7

Complete the “DLP-G426 Edit an OCHNC Circuit Name” task on page 17-51, as needed.

Step 8

Complete the “DLP-G420 Change an OCHNC Administrative State” task on page 17-53, as needed.

Step 9

Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 17-50, as needed.
Stop. You have completed this procedure.
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NTP-G334 Configure GMPLS Optical Restoration
Purpose

This procedure configures optical restoration for GMPLS circuits.

Tools/Equipment

None

Prerequisite Procedures None
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the DLP-G46 Log into CTC at a node on the network where you want to configure GMPLS
optical restoration. If you are already logged in, continue with Step 2.

Step 2

Complete the DLP-G709 Provision GMPLS Optical Channel Network Connections, page 17-47 as
needed.

Step 3

Complete the DLP-G708 Create a GMPLS Optical Channel Trail, page 17-37 as needed.

Step 4

Complete the DLP-G732 Edit a GMPLS OCHNC or OCH Trail Circuit, page 17-52.

Step 5

Complete the DLP-G731 Clear WSON Alarms, page 17-42 as needed.

Step 6

Complete the DLP-G733 Configure GMPLS UNI, page 17-43 as needed.
Stop. You have completed this procedure.

DLP-G731 Clear WSON Alarms
Purpose

This task clears the unverified alarms that appear in the WSON tab at the
node, network, and circuit levels.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Clear the alarms at the node, network, or circuit levels.
Clear the alarms at the node level.
a.

From the View menu, choose Go to Home View.

b.

Click the Maintenance > DWDM > WSON tabs to view the list of unverified alarms at the node
level.

c.

Choose each alarm and click Acknowledge to clear the unverified alarms at the node level.
Clear the alarms at the network level.

d.

Click the DWDM Functional View icon in the toolbar. The DWDM Functional View (NFV)
window opens.
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e.

In the Network Data pane, click the WSON tab to view the list of unverified alarms at the network
level.

f.

Choose each alarm and click Acknowledge to clear the unverified alarms at the network level.
Clear the alarms at the circuit level.

Step 2

g.

Click the DWDM Functional View icon in the toolbar. The DWDM Functional View (NFV)
window opens.

h.

From the Change Perspective drop-down list in the toolbar, choose NFV. The NFV window opens.

i.

From the Circuits tab, choose a GMPLS circuit that you want to edit.

j.

Click the WSON tab to view the list of unverified alarms at the circuit level.

k.

Choose each alarm and click Acknowledge to clear the unverified alarms at the circuit level.

Return to your originating procedure (NTP).

DLP-G733 Configure GMPLS UNI
Purpose

This procedure configures the GMPLS UNI on a DWDM node and the
router.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Home View.

Step 2

Click the Provisioning > WDM-ANS > GMPLS/WSON > UNI tabs.

Step 3

Click Create.

Step 4

In the UNI window, provision the following parameters:
•

Rx Port Selection—Choose the card type from the Type drop-down list; choose a shelf from the
Shelf drop-down list; choose a source slot from Slot drop-down list and choose a port from the Port
drop-down list.

•

Tx Port Selection—Choose the card type from the Type drop-down list; choose a shelf from the
Shelf drop-down list; choose a destination slot from Slot drop-down list and choose a port from the
Port drop-down list.

•

UNI State—Choose Enable or Disable from the UNI State drop-down list.
The Enable state is used to configure the UNI interface for the circuits to pass through, between the
router and DWDM node. In the Disable state, the interface is configured but not active and circuit
activation is rejected. When the status is changed from Enable to Disable, all the active circuits on
the interface are deleted.

•

Description—Enter the description of the UNI interface. The description can be up to 256
characters.

•

Remote System IP—Enter the IP address of the router.

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x
78-20702-02

17-43

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords

DLP- G733 Configure GMPLS UNI

Step 5

•

Remote Interface IP—Enter the IP address of the client side of the UNI, that is, the UNI-C interface.

•

MSTP Interface IP—Enter the IP address of the network side of the UNI, that is, the UNI-N
interface.

•

Remote Communication Channel—Enter the IP address of the communication channel remote
end-point. If the IP address is not provided, the remote system IP address is used as the remote
communication channel address. The remote communication channel address must be defined if the
remote system IP address is not a routable address. If the remote communication channel address is
not defined, the UNI client uses another address as source address for signaling messages.

•

Remote Router Interface—From the Interface Location drop-down list, choose None, POS,
TenGigE, or HundredGigE and enter the remote router interface.

•

Validation—Set the validation mode. For more information about the validation modes, see the
“12.10.1.3 Validation Modes” section on page 12-110.

•

Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit
is created if the actual optical validation result is greater than or equal to the value set in this field.
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance
Thresholds” section on page 12-110.

•

Restoration—Check this check box to enable the restoration of the GMPLS circuits on the UNI
interface.

•

Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

•

Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit
on the restored path waits before moving to the original path after the failure is fixed. The circuit
reverts to the original path after the soak time expires. The soak time must be set only if both the
Restoration and Revert check boxes are checked.

Click OK to configure the UNI on a DWDM node.

Note

When the UNI is configured on a DWDM node, CTC runs the necessary CLI commands to
configure the UNI on the connected router.

Stop. You have completed this procedure.
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DLP-G105 Provision Optical Channel Network Connections
Purpose

This task creates an OCHNC between two optical nodes upon a specified
C-band or L-band wavelength through the ports residing on the 32WSS,
32WSS-L, 40-WSS-C, 40-WSS-CE, 32DMX-O, 32DMX, 32DMX-L,
40-DMX-C, 40-DMX-CE, 4MD-xx.x, AD-1C-xx.x, AD-4C-xx.x,
40-SMR1-C, 40-SMR2-C, 80-WXC-C, 15216-FLD-4,
15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN, and
15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD
wavelength selective switches, multiplexers, demultiplexers, and add/drop
cards:
OCH trails, which carry OCHCC circuits, are associated to the OCHNCs.

Tools/Equipment
Prerequisite Procedures

Note

None
•

DLP-G46 Log into CTC

•

An OCHNC add port on the source node and an OCHNC drop port on
destination node of the same wavelength

•

Cisco Transport Planner Traffic Matrix Report

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

In a node using OTU2_XP cards configured in the regen mode, you must create two OCHNC circuits,
one on either side of the card.

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab, then click Create.

Step 3

In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list.

Step 4

Click Next.

Step 5

In the Circuit area of the Circuit Attributes page, provision the OCHNC circuit attributes:
•

Name—Assign a name to the OCHNC. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor
circuits. If you leave the field blank, CTC assigns a default name to the circuit. When a circuit
includes a network element with release prior to 9.60, the circuit name is limited to 48 characters.

•

Type—(Display only) OCHNC.

•

Size—(Display only) Equipped non specific is the default.

•

OCHNC Wavelength—Choose a band (either C Band or L Band) and wavelength number type
(Odd or Even) in the lower drop-down list. Then, choose the wavelength that you want to provision
in the upper drop-down list. See Table 17-6 on page 17-20 for C-band and Table 17-7 on page 17-22
for L-band wavelengths.

•

Bidirectional—Check this box to create a bidirectional OCHNC; uncheck it to create a
unidirectional OCHNC.
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•

OCHNC DCN—Check this box to create an OCHNC DCN. The OCHNC DCN establishes
preliminary connectivity between nodes that lack LAN or optical service channel (OSC)
connections. After the OCHNC is created, you create a GCC termination to provide permanent
communications channel between the nodes. See the “DLP-G76 Provision DCC/GCC
Terminations” task on page 17-88.

•

Protection—Check to create a protected OCHNC. For more details, see the “DLP-G493 Provision
Protected Optical Channel Network Connections” task on page 17-49.

•

State—Provisions the OCHNC circuit state. The state can be IS,AINS (ANSI)/Unlocked,
automatic in-service (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

Step 6

Click Next.

Step 7

In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list,
and, if needed, the source or ADD/DROP port from the Port drop-down list.
The source In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 8

Click Next.

Step 9

In the Circuit Destination area, choose the destination node from the Node drop-down list, then choose
the destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the
Slot drop-down list, and, if needed, the destination port from the Port drop-down list.
The destination In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 10

Click Next.

Step 11

Skip this step and continue with Step 12 if no constraints are needed. If the trunk ports are already
connected by an existing OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing
Preferences page appears in read-only mode; all buttons are disabled. Continue with Step 12. If not,
complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31.

Step 12

Click Finish. The Circuit Creation wizard closes and the new OCHNC appears in the Circuits table with
a DISCOVERED status in the Status column. (The circuit might take a few minutes to come up,
depending on the size of the network.)

Step 13

Return to your originating procedure (NTP).
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DLP-G709 Provision GMPLS Optical Channel Network Connections
Purpose

This task provisions an OCHNC between two optical nodes upon a
specified C-band wavelength through the ports residing on the 32WSS,
40-WSS-C, 40-WSS-CE, 32DMX, 40-DMX-C, 40-DMX-CE,
40-SMR1-C, 40-SMR2-C, 80-WXC-C, 100G-LC-C, 10x10G-LC, AR_XP,
AR_XPE, 15216-MD-40-EVEN, 15216-EF-40-EVEN, or
15216-MD-48-EVEN, and 15216-MD-40-ODD, 15216-EF-40-ODD, or
15216-MD-48-ODD wavelength selective switches, multiplexers,
demultiplexers, and add/drop cards:

Tools/Equipment

Cisco Transport Planner Traffic Matrix Report

Prerequisite Procedures

•

DLP-G46 Log into CTC

•

An OCHNC add port on the source node and an OCHNC drop port on
destination node of the same wavelength

•

DLP-G350 Use the Cisco Transport Planner Traffic Matrix Report

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Parent View. The Network view opens.

Step 2

Open the source node in the Network view either by double-clicking the node or right-clicking the node
and choosing the Open Node option.

Step 3

Select the Provisioning > WDM-ANS > GMPLS/WSON tabs.

Step 4

Define the fiber attributes and alien wavelength parameters for the node in the Fiber Attributes and Alien
Wavelength tabs, as needed. For more information about alien wavelength parameters, see the
“12.10.3.5 Fiber Attributes and Alien Wavelength Provisioning” section on page 12-121.

Step 5

Repeat the Step 1 through Step 3 for the destination node.

Step 6

From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV view
opens.

Step 7

From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 8

In the circuit parameters pane, provision the OCHNC circuit attributes:
a.

Name—Assign a name to the circuit. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). When a circuit includes a network element with release prior to 9.60, the circuit name is
limited to 48 characters.

b.

Type—Choose OCHNC.

c.

Protected—Check to route the circuit on a protected path. Select the protection type from the
drop-down list. The available option is:
– PSM—When a PSM card is connected to a TXP card.

d.

OCHNC Wavelength—Provides three fields to define the wavelength for the OCHCC circuit.
Choose a wavelength from the first field. In the second field, change the wavelength band by
choosing C Band. In the third field, indicate whether odd or even C-band wavelengths appear.
Table 17-6 lists the C-band wavelengths.
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e.

Protected OCHNC Wavelength—Define the wavelength of the protected OCHCC circuit. This field
is visible only when the Protected check box is checked in Step c. The options available are similar
to that of OCHNC Wavelength.

f.

Validation—Set the validation mode. For more information about the validation modes, see the
“12.10.1.3 Validation Modes” section on page 12-110.

g.

Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit
is created if the actual optical validation result is greater than or equal to the value set in this field.
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance
Thresholds” section on page 12-110.

h.

Protection Acceptance Threshold—Set the optical validation threshold value for the protected
GMPLS circuit.

i.

Ignore Path Alarms—Check this check box to ignore the alarms on the path and create the circuit.
This parameter is used to verify whether the circuit can be created on the path.

Step 9

Configure the restoration parameters for the OCHNC circuit in the GMPLS/WSON Restoration
Configuration pane. For more information about configuring the restoration parameters, see the
12.10.3.6 GMPLS Restoration Configuration, page 12-122.

Step 10

Configure the source and destination ports in the map. For more information about configuring the
source and destination ports, see the “12.10.3.3 Source and Destination Port Configuration” section on
page 12-119.

Note

The OCHNC circuit endpoints must be selected on channel ports, express add/drop ports, or
add/drop ports. If other ports are selected, a warning dialog box is displayed prompting you to
change the circuit type.

After the ports are selected, the Alien Wavelength Selection pane is displayed. This pane displays
options for the RX and TX channels at the endpoints of the circuit.
Step 11

For both RX and TX channels, choose the alien class and the forward error correction (FEC) mode from
the corresponding drop-down lists. For more information about FEC, see “G.8 FEC” section on
page G-18. Click Apply in the Alien Wavelength Selection pane.

Step 12

Click Apply in the Circuit Parameters pane.

Step 13

Click Yes in the Create Circuits confirmation dialog box.
The OCHNC circuit appears in the Circuits tab in the Network Data pane. After the circuit status has
been verified, the DISCOVERED status appears in the Status column. The circuit might take a few
minutes to come up, depending on the size of the network.

Step 14

Return to your originating procedure (NTP).
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DLP-G493 Provision Protected Optical Channel Network Connections
Purpose

This task creates a protected OCHNC circuit when a PSM card is
provisioned at the endpoint nodes of a DWDM network. OCH trails, which
carry OCHCC circuits, are associated to the OCHNCs.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
An OCHNC add port on the source node and an OCHNC drop port on
destination node of the same wavelength
Cisco Transport Planner Traffic Matrix Report
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab, then click Create.

Step 3

In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list.

Step 4

Click Next.

Step 5

In the Circuit area of the Circuit Attributes page, provision the OCHNC circuit attributes:

Step 6

•

Name—Assign a name to the OCHNC. The name is limited to 80 characters, which can be a
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor
circuits. If you leave the field blank, CTC assigns a default name to the circuit. When a circuit
includes a network element with release prior to 9.60, the circuit name is limited to 48 characters.

•

Type—(Display only) OCHNC.

•

Size—(Display only) Equipped non specific is the default.

•

OCHNC Wavelength—Choose a band (either C Band or L Band) and wavelength number type
(Odd or Even) in the lower drop-down list. Then, choose the wavelength that you want to provision
in the upper drop-down list. See Table 17-6 on page 17-20 and Table 17-7 on page 17-22 for C-band
and L-band wavelengths.

•

Bidirectional—Check this box to create a bidirectional OCHNC; uncheck it to create a
unidirectional OCHNC. This field is not available if you check the Protection option.

•

OCHNC DCN—Check this box to create an OCHNC DCN. The OCHNC DCN establishes
preliminary connectivity between nodes that lack LAN or optical service channel (OSC)
connections. After the OCHNC is created, you create a GCC termination to provide permanent
communications channel between the nodes. See the “DLP-G76 Provision DCC/GCC
Terminations” task on page 17-88.

•

Protection—Check to create a protected OCHNC (only endpoint nodes equipped with PSM cards
will be selectable as circuit endpoints).

•

State—Provisions the OCHNC circuit state. The state can be IS,AINS (ANSI)/Unlocked,
automatic in-service (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

Click Next.
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Step 7

In the Circuit Source area, choose the source node from the Node drop-down list. Only endpoint nodes
equipped with PSM cards are available for selection in the Node drop-down list. The slot, port, and the
source In and Out OTS lines are automatically chosen by CTC.

Step 8

Click Next.

Step 9

In the Circuit Destination area, choose the destination node from the Node drop-down list. Only endpoint
nodes equipped with PSM cards are available for selection in the Node drop-down list. The slot, port,
and the source In and Out OTS lines are automatically chosen by CTC.

Step 10

Click Next. CTC completes the circuit creation by routing two distinct paths (a working path and a
protected path) from the source node to the destination node. The working path is the one exiting the
In/Out working source OTS lines and entering the In/Out working destination OTS lines. The protected
path is the one exiting the In/Out protected source OTS lines and entering the In/Out protected
destination OTS lines.

Step 11

Complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31. Skip this step and
continue with Step 12 if no constraints are needed. If the trunk ports are already connected by an existing
OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in
read-only mode; all buttons are disabled. Continue with Step 12.

Step 12

Click Finish. The Circuit Creation wizard closes and the new OCHNC appears in the Circuits table with
a DISCOVERED status in the Status column. (The circuit might take a few minutes to appear, depending
on the size of the network.)

Step 13

Return to your originating procedure (NTP).

DLP-G106 Delete Optical Channel Network Connections
Purpose

This task deletes DWDM OCHNC circuits.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

If you are deleting more than half of all the active OCHNCs, it is recommended that you delete them two
at a time to allow for proper power compensation. You do not need to delete the active OCHNCs two at
a time if you are deleting all the them.

Step 1

To preserve existing settings you must back up the database of every node on the path of the circuit.
Complete the “NTP-G103 Back Up the Database” task on page 24-2 to back up the databases for all
nodes on the circuit path. Record the circuit information if you plan to recreate the circuit.

Step 2

Consult your NOC or other appropriate personnel to verify that the OCHNC can be safely deleted.

Step 3

Investigate all network alarms and resolve any problems that might be affected by the OCHNC deletion.

Step 4

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 5

In the Circuits table, under the Type column, choose one or more OCHNCs that you want to delete. (To
choose more than one OCHNC, press the Shift or Control keys as you click the circuits.)
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Step 6

Click Delete.

Step 7

In the Delete Circuits confirmation dialog box, check Notify when completed, as needed.
If checked, the CTC Alerts confirmation dialog box will alert you when the OCHNC is deleted. During
this time, you cannot perform other CTC functions. If you are deleting many OCHNCs, waiting for
confirmation might take a few minutes. Circuits are deleted whether or not this check box is checked.

Note

Step 8

Step 9

The CTC Alerts dialog box will not automatically open to show a deletion error unless you
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see
the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC Alerts
dialog box is not set to open automatically with a notification, the red triangle inside the CTC
Alerts toolbar icon indicates that a notification exists.

Complete either of the following:
•

If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

•

If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.

If you want to save the information in the CTC Alerts dialog box, complete the following steps.
a.

Click Save.

b.

Click Browse and navigate to the directory where you want to save the file.

c.

Type the file name using a.txt file extension, and click OK.

Step 10

Click Close to close the CTC Alerts dialog box.

Step 11

Complete the “NTP-G103 Back Up the Database” task on page 24-2 for every node on the path of the
circuit if you require a backup of your changes.

Step 12

Return to your originating procedure (NTP).

DLP-G426 Edit an OCHNC Circuit Name
Purpose

This task changes the name of an OCHNC circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G105 Provision Optical Channel Network Connections, page 17-45
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

To rename the OCHCC circuit, do either of the following.

Step 3

•

Network view—Select the OCHCC circuit in the Circuits tab and click Edit.

•

NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

In the Edit Circuit dialog box, click the General tab.
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Step 4

In the Name field, enter the new OCHNC circuit name.

Step 5

Click Apply.

Step 6

Return to your originating procedure (NTP).

DLP-G732 Edit a GMPLS OCHNC or OCH Trail Circuit
Purpose

This task edits the parameters of a GMPLS OCHNC or OCH Trail circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G709 Provision GMPLS Optical Channel Network Connections,
page 17-47
DLP-G708 Create a GMPLS Optical Channel Trail, page 17-37

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

For OCHNC UNI circuits, only Restoration and Restoration and Revert options are supported. The
Manual Revert and Upgrade Restored options are not applicable.

Step 1

From the View menu, choose Go to Network View and click the DWDM Functional View icon in the
toolbar. The DWDM Functional View (NFV) window opens.

Step 2

From the Change Perspective drop-down list in the toolbar, choose NFV. The NFV window opens.

Step 3

From the Circuits tab, choose a OCH Trail or OCHNC GMPLS circuit that you want to edit.

Step 4

Click the Restoration tab to edit the following restoration and revertive parameters:

Step 5

a.

Check the Restoration check box to switch the circuit from the original path to an alternate path
because of failure in the original path.

b.

Check the Revert check box to revert the circuit from the restored path to the original path after the
failure is fixed.

c.

Click the Auto Revert radio button to automatically revert the circuit from the restored path to the
original path after the failure is fixed, alarms listed in the WSON tab are acknowledged, and the soak
time expires.

d.

Click the Manual Revert radio button to manually revert the circuit from the restored path to the
original path after the failure is fixed, alarms listed in the WSON tab are acknowledged, and the soak
time expires.

e.

Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on the restored
path waits before moving to the original path after the failure is fixed.

Click Manual Revert to revert the circuit to the original path from the restored path after the soak time
expires.
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Note

The circuit can be manually reverted only when the restoration status of the circuit is
REST-REVERTIBLE.

Note

In a PSM protected trail circuit, click the Manual Revert button twice to revert the working and
protected trail circuit respectively.

Step 6

Click Upgrade Restored to discard the original path and make the restored path as the working path.

Step 7

Click Apply to save the changes.

Step 8

Click the WSON tab to acknowledge the unverified alarms.

Step 9

Step 10

a.

Right-click the alarm and choose Select Affected Circuits to view the circuits affected by this
alarm.

b.

Choose each alarm and click Acknowledge to clear the unverified alarms.

Click Revert Test to forcefully revert the circuit from the restored path to the original path.

Note

When the circuit is forcefully reverted, the circuit cannot be restored and reverted. If the failure
is not fixed in the original path, the circuit becomes unusable and traffic is affected. The revert
test is possible only when all the alarms on the original path are acknowledged.

Note

In a PSM protected trail circuit, if a working or protect trail circuit is restored, the Revert Test
button reverts the restored trail to the original path. If both the working and protected trail
circuits are restored, the Revert Test button reverts either the working or protected trail circuit.
The user must click the Revert Test button again to revert the other trail circuit.

Return to your originating procedure (NTP).

DLP-G420 Change an OCHNC Administrative State
Purpose

This task changes the administrative state of an OCHNC circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45
DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2

To change the administrative state of the OCHCC circuit, do either of the following.
•

Network view—Select the OCHCC circuit in the Circuits tab and click Edit.
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•

NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3

In the Edit Circuit dialog box, click the State tab.

Step 4

Choose an administrative state from the drop-down list:
•

IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

•

OOS (ANSI) or Locked (ETSI)

Step 5

Click Apply.

Step 6

If you are changing the OCHNC state to OOS,DSBLD (ANSI) or Locked,Disabled (ETSI), click OK in
the confirmation dialog box. (No confirmation dialog box appears when you place OCH trails in
service.)
For information about the OCH circuit state transitions, see the Administrative and Service States
document.

Step 7

Return to your originating procedure (NTP).

DLP-G710 Reroute Wavelength of GMPLS Circuits
Purpose

This task reroutes an existing GMPLS circuit through an alternate path
based on the specified path constraints.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

GMPLS OCHCC circuits cannot be rerouted. Only the OCH Trail associated with the OCHCC circuit
can be rerouted.

Step 1

From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV view
opens.

Step 2

From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 3

Click the Wavelength re-routing button.

Step 4

In the confirmation dialog box, click Yes to enter the wavelength re-routing view. The Wavelength
re-routing pane is displayed.

Step 5

In the Circuits tab, select the GMPLS circuit to be rerouted.

Step 6

From the Constraint Config drop-down list, select the required constraint type. For more information
about the various constraint types, see the Table 12-18.

Step 7

In the map, select the node or link to which the constraint is to be applied.

Step 8

Repeat Step 5 and Step 6 to apply more constraints, as needed.
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Note

While applying constraint to include a node or link on the alternate path, the selection of the
nodes or links must be done sequentially, starting form the source to the destination of the
circuit.

Step 9

Click Apply. The circuit is rerouted if a feasible path is found that complies with the specified
constraints. After a successful reroute, a confirmation message is displayed. Otherwise, a failure
notification is displayed.

Step 10

Repeat the reroute process in case the reroute fails in Step 9. Click Clear in the Wavelength
re-routing pane to clear the previous selections. Repeat the Step 6 through Step 9.

Step 11

Click the Wavelength re-routing button on the toolbar to close the Wavelength re-routing pane. In the
confirmation dialog box, click Yes.

Step 12

Return to your originating procedure (NTP).

NTP-G200 Create, Delete, and Manage STS or VC Circuits for the
ADM-10G Card
Purpose

This procedure creates and deletes STS and VC circuits for the ADM-10G
card.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the DLP-G46 Log into CTC at a node on the network where you want to manage the STS or
VC circuits. If you are already logged in, continue with Step 2.

Step 2

If you want to assign a name to the STS or VC source and destination ports before you create the circuit,
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with the next
step.

Step 3

If you are creating STS or VC circuits on ADM-10G cards across two nodes, you must complete the
“DLP-G395 Create an Optical Channel Trail” task on page 17-35. If not, continue with the next step.

Step 4

Complete the “DLP-G463 Create an Automatically Routed STS or VC Circuit” task on page 17-56, as
needed.

Step 5

Complete the “DLP-G464 Create a Manually Routed STS or VC Circuit” task on page 17-59, as needed.

Step 6

Complete the “DLP-G467 Edit an STS or VC Circuit Name” task on page 17-64, as needed.

Step 7

Complete the “DLP-G466 Delete an STS or VC Circuit” task on page 17-63, as needed.
Stop. You have completed this procedure.
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DLP-G463 Create an Automatically Routed STS or VC Circuit
Purpose

This procedure creates an automatically routed STS or VC circuit for the
ADM-10G card. CTC chooses the circuit route based on the parameters
you specify and on the software version.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE
default are set to FALSE. For a full description of these defaults see the Network Element Defaults.

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab, then click Create.

Step 3

In the Circuit Creation dialog box, complete the following fields:
•

Circuit Type—Choose STS or VC from the Circuit Type list.

•

Number of Circuits—Enter the number of STS or VC circuits that you want to create. The default
is 1. If you are creating multiple circuits with the same slot and sequential port numbers, you can
use Auto-ranged to create the circuits automatically.

•

Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of
Circuits field. Auto-ranging creates identical (same source and destination) sequential circuits
automatically. Uncheck the box if you do not want CTC to create sequential circuits automatically.

Step 4

Click Next.

Step 5

Define the circuit attributes:
•

Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 43 characters or less if you want the ability to create
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

•

Size—Choose the circuit size.
– Available SONET circuits are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-18c, STS-24c,

STS-36c, STS-48c, and STS-192c.
– Available SDH circuits areVC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c,

VC4-16c, and VC4-64c.

•

Note

For creating a circuit using a Gigabit Ethernet port, choose the circuit size as STS-24c for a
SONET circuit or VC4-8c for a SDH circuit.

Note

An equivalent SDH circuit size for STS-1 SONET circuit does not exist.

Bidirectional—Leave checked for this circuit (default).
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•

Create cross-connects only (TL1-like)—Check this box if you want to create one or more
cross-connects to complete a signal path for TL1-generated circuits.

•

Diagnostic—Leave unchecked.

•

State—Choose the administrative state to apply to all of the cross-connects in a circuit:
– IS (ANSI)/Unlocked (ETSI)—Puts the circuit cross-connects in the IS-NR (ANSI) or

unlocked-enabled (ETSI) service state.
– OOS,DSBLD (ANSI)/Locked,Disabled (ETSI)—Puts the circuit cross-connects in the

OOS-MA,DSBLD (ANSI) or locked-enabled,disabled (ETSI) service state. Traffic is not passed
on the circuit.
– IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI)—Puts the circuit cross-connects in the

OOS-AU,AINS (ANSI) or unlocked-disabled,automaticInService (ETSI) service state and
suppresses alarms and conditions. When the connections receive a valid signal, the service state
automatically changes to IS-NR (ANSI) or unlocked-enabled (ETSI).
– OOS,MT (ANSI)/Locked,maintenance (ETSI)—Puts the circuit cross-connects in the

OOS-MA,MT (ANSI) or locked-enabled,maintenance (ETSI) service state. The maintenance
state does not interrupt traffic flow; it suppresses alarms and conditions and allows loopbacks
to be performed on the circuit. Use OOS,MT (ANSI) or locked,maintenance (ETSI) for circuit
testing or to suppress circuit alarms temporarily.
•

Apply to drop ports—Check this check box if you want to apply the administrative state chosen in
the State field to the circuit source and destination ports. CTC applies the administrative state to the
ports only if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is
larger than the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog
box displays the ports where the administrative state could not be applied. If the check box is
unchecked, CTC does not apply the administrative state to the source and destination ports.

Note

•

If ports managed into the IS (ANSI) or Unlocked (ETSI) administrative state are not
receiving signals, loss of signal alarms are generated and the port service state transitions to
OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI).

Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to
ONS 15454 cards that are in 1:1, 1:N, 1+1, or optimized 1+1 protection. If you check this box, CTC
displays only protected cards and ports as source and destination choices.

Step 6

If the circuit will be routed on a path protection configuration, complete the “DLP-G465 Provision Path
Protection Selectors” task on page 17-62. Otherwise, continue with Step 7.

Step 7

Click Next.

Step 8

In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list,
and, if needed, the source port from the Port drop-down list. For most cards, the port will be
automatically chosen.

Step 9

If you need to create a secondary source, for example, a path protection bridge/selector circuit entry
point in a multivendor path protection configuration, click Use Secondary Source and repeat Step 8 to
define the secondary source. If you do not need to create a secondary source, continue with Step 10.

Step 10

Click Next.
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Step 11

In the Circuit Destination area, choose the destination node from the Node drop-down list (only the
source node will be available because the source and destination nodes are the same), then choose the
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot
drop-down list, and, if needed, the destination port from Port drop-down list.

Step 12

Click Next.

Step 13

In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose
either, both, or none based on your preferences.
•

Using Required Nodes/Spans—Check this check box if you want to specify nodes and spans to
include or exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the working path
of the circuit (but not the protect path). Excluding nodes and spans ensures that the nodes and spans
are not in the working or protect path of the circuit.

•
Step 14

Step 15

Step 16

Review Route Before Creation—Check this check box if you want to review and edit the circuit
route before the circuit is created.

To set the circuit path protection, complete one of the following:
•

To route the circuit on a protected path, leave Fully Protected Path checked and continue with
Step 15. CTC creates a fully protected circuit route based on the path diversity option you choose.
Fully protected paths might or might not have path protection path segments (with primary and
alternate paths), and the path diversity options apply only to path protection path segments, if any
exist.

•

To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 16.

If you selected Fully Protected Path in Step 14 and the circuit will be routed on a path protection
configuration, choose one of the following:
•

Nodal Diversity Required—Ensures that the primary and alternate paths within path protection
portions of the complete circuit path are nodally diverse.

•

Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

•

Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path
protection portions of the complete circuit path are needed. The paths might be node-diverse, but
CTC does not check for node diversity.

If you checked Using Required Nodes/Spans in Step 13, complete the following substeps. Otherwise,
continue with Step 17.
a.

In the Circuit Constraints for Automatic Routing area, click a node or span on the circuit map.

b.

Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span
from the circuit. The order in which you choose included nodes and spans is the order in which the
circuit is routed. Click spans twice to change the circuit direction.

c.

Repeat Step b for each node or span you wish to include or exclude.

d.

Review the circuit route. To change the circuit routing order, choose a node in the Required
Nodes/Lines or Excluded Nodes Links lists and click the Up or Down buttons to change the circuit
routing order. Click Remove to remove a node or span.

Step 17

Click Next.

Step 18

If you selected Review Route Before Creation in Step 13, complete the following substeps. If not,
continue with Step 19.
a.

Click Next.
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Step 19

Step 20

b.

Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead,
then click Include to include the span or Remove to remove the span.

c.

If the provisioned circuit does not reflect the routing and configuration you want, click Back to
verify and change circuit information. If the circuit needs to be routed to a different path, see the
“DLP-G464 Create a Manually Routed STS or VC Circuit” procedure on page 17-59.

Click Finish. One of the following results occurs if you entered more than one circuit in the Number of
Circuits field on the Circuit Creation dialog box.
•

If you chose Auto-ranged, CTC automatically creates the number of circuits entered in the Number
of Circuits field. If auto-ranging cannot complete all the circuits, for example, because sequential
ports are unavailable at the source or destination, a dialog box appears. Set the new source or
destination for the remaining circuits, then click Finish to continue auto-ranging. After completing
the circuits, the Circuits window appears.

•

If you did not choose Auto-ranged, the Circuit Creation dialog box appears so you can create the
remaining circuits. Repeat Steps 3 through 18 for each additional circuit. After completing the
circuits, the Circuits window appears.

In the Circuits window, verify that the new circuits appear in the circuits list.
Stop. You have completed this procedure.

DLP-G464 Create a Manually Routed STS or VC Circuit
Purpose

This procedure creates an STS or VC circuit and allows you to provision
the circuit route for the ADM-10G card.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab, then click Create.

Step 3

In the Circuit Creation dialog box, complete the following fields:
•

Circuit Type—Choose STS or VC from the Circuit Type list.

•

Number of Circuits—Enter the number of STS or VC circuits that you want to create. The default
is 1.

•

Auto-ranged—(Automatically routed circuits only) If you entered more than 1 in the Number of
Circuits field on the Circuit Creation dialog box, uncheck this box. (The box is unavailable if only
one circuit is entered in the Number of Circuits field.)

Step 4

Click Next.

Step 5

Define the circuit attributes:
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•

Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 43 characters or less if you want the ability to create
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

•

Size—Choose the circuit size.
– Available SONET are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-18c, STS-24c,

STS-36c, STS-48c, and STS-192c.
– Available SDH circuits are VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c,

VC4-16c, and VC4-64c.

Note

For creating a circuit using a Gigabit Ethernet port, choose the circuit size as STS-24c for a
SONET circuit or VC4-8c for a SDH circuit.

•

Bidirectional—Leave checked for this circuit (default).

•

Create cross-connects only (TL1-like)—Check this box if you want to create one or more
cross-connects to complete a signal path for TL1-generated circuits.

•

State—Choose the administrative state to apply to all of the cross-connects in a circuit:
– IS (ANSI)/Unlocked (ETSI)—Puts the circuit cross-connects in the IS-NR (ANSI) or

unlocked-enabled (ETSI) service state.
– OOS,DSBLD (ANSI)/Locked,Disabled (ETSI)—Puts the circuit cross-connects in the

OOS-MA,DSBLD (ANSI) or locked-enabled,disabled (ETSI) service state. Traffic is not passed
on the circuit.
– IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI)—Puts the circuit cross-connects in the

OOS-AU,AINS (ANSI) or unlocked-disabled,automaticInService (ETSI) service state and
suppresses alarms and conditions. When the connections receive a valid signal, the service state
automatically changes to IS-NR (ANSI) or unlocked-enabled (ETSI).
– OOS,MT (ANSI)/Locked,maintenance (ETSI)—Puts the circuit cross-connects in the

OOS-MA,MT (ANSI) or locked-enabled,maintenance (ETSI) service state. The maintenance
state does not interrupt traffic flow; it suppresses alarms and conditions and allows loopbacks
to be performed on the circuit. Use OOS,MT (ANSI) or locked,maintenance (ETSI) for circuit
testing or to suppress circuit alarms temporarily.
•

Apply to drop ports—Check this check box if you want to apply the administrative state chosen in
the State field to the circuit source and destination ports. CTC applies the administrative state to the
ports only if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is
larger than the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog
box displays the ports where the administrative state could not be applied. If the check box is
unchecked, CTC does not apply the administrative state to the source and destination ports.

Note

•

Step 6

If ports managed into the IS (ANSI) or Unlocked (ETSI) administrative state are not
receiving signals, loss of signal alarms are generated and the port service state transitions to
OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI).

Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to
ONS 15454 cards that are in 1:1, 1:N, 1+1, or optimized 1+1 protection. If you check this box, CTC
shows only protected cards and ports as source and destination choices.

If the circuit will be routed on a path protection configuration, complete the “DLP-G465 Provision Path
Protection Selectors” task on page 17-62. Otherwise, continue with Step 7.
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Step 7

Click Next.

Step 8

In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list,
and, if needed, the source port from the Port drop-down list. For most cards, the port will be
automatically chosen.

Step 9

If you need to create a secondary source, for example, a path protection bridge/selector circuit entry
point in a multivendor path protection configuration, click Use Secondary Source and repeat Step 8 to
define the secondary source. If you do not need to create a secondary source, continue with Step 10.

Step 10

Click Next.

Step 11

In the Circuit Destination area, choose the destination node from the Node drop-down list (only the
source node will be available because the source and destination nodes are the same), then choose the
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot
drop-down list, and, if needed, the destination port from Port drop-down list.

Step 12

Click Next.

Step 13

In the Circuit Routing Preferences area, uncheck Route Automatically.

Step 14

To set the circuit path protection, complete one of the following:

Step 15

•

To route the circuit on a protected path, leave Fully Protected Path checked and continue with
Step 15. Fully protected paths might or might not have path protection path segments (with primary
and alternate paths), and the path diversity options apply only to path protection path segments, if
any exist.

•

To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 17.

If you selected Fully Protected Path in Step 14 and the circuit will be routed on a path protection
configuration, choose a Node-Diverse Path option:
•

Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection
portions of the complete circuit path are nodally diverse.

•

Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

•

Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path
protection portions of the complete circuit path are needed. The paths might be node-diverse, but
CTC does not check for node diversity.

Step 16

Click Next.

Step 17

In the Route Review/Edit area, node icons appear for you to route the circuit manually. Click the source
node icon if it is not already selected.

Step 18

Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The
arrow turns yellow. In the Selected Span area, the From and To fields provide span information. The
source STS or VC appears.

Step 19

If you want to change the source STS or VC, adjust the Source STS or VC field; otherwise, continue
with Step 20.

Step 20

Click Add Span. The span is added to the Included Spans list and the span arrow turns blue.

Step 21

If the Fully Protect Path check box is checked in the Circuit Routing Preferences panel, you must add
two spans for all path protection or unprotected portions of the circuit route from the source to the
destination.

Step 22

Repeat Steps 18 through 21 until the circuit is provisioned from the source to the destination node
through all intermediary nodes.
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Step 23

Click Finish. CTC compares your manually provisioned circuit route with the specified path diversity
option you chose in Step 15. If the path does not meet the specified path diversity requirement, CTC
displays an error message and allows you to change the circuit path.

Step 24

If you entered more than 1 in the Number of Circuits field on the Circuit Creation dialog box, the Circuit
Creation dialog box appears so you can create the remaining circuits. Repeat Steps 3 through 23 for each
additional circuit.

Step 25

When all the circuits are created, the main Circuits window appears. Verify that the circuits you created
are correct.
Stop. You have completed this procedure.

DLP-G465 Provision Path Protection Selectors
Purpose

This task provisions path protection selectors during circuit creation or
during a topology upgrade conversion.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
The Circuit Attributes page of the Circuit Creation wizard must be open.

Note

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Provisioning path signal degrade (SD-P) or path signal fail (SF-P) thresholds in the Circuit Attributes
page of the Circuit Creation wizard sets the values only for path protection-protected spans. The circuit
source and destination use the node default values of 10E-4 for SD-P and 10E-6 for SF-P for unprotected
circuits and for the source and drop of path protection circuits.
In the path protection area of the Circuit Attributes page of the Circuit Creation wizard, set the path
protection selectors:
•

Provision working go and return on primary path—Check this box to route the working path on one
fiber pair and the protect path on a separate fiber pair. This feature only applies to bidirectional path
protection circuits.

•

Revertive—Check this box if you want traffic to revert to the working path when the conditions that
diverted it to the protect path are repaired. If you do not choose Revertive, traffic remains on the
protect path after the switch.

•

Reversion time—If Revertive is checked, click the Reversion time field and choose a reversion time
from the drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the
amount of time that will elapse before the traffic reverts to the working path. Traffic can revert when
conditions causing the switch are cleared.

•

SF threshold—Set the path protection path-level signal failure bit error rate (BER) thresholds.

•

SD threshold—Set the path protection path-level signal degrade BER thresholds.

•

Switch on PDI-P—Check this box if you want traffic to switch when an STS or VC payload defect
indicator is received.
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Step 2

Return to your originating procedure (NTP).

DLP-G466 Delete an STS or VC Circuit
Purpose

This task deletes STS or VC circuits.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “NTP-G103 Back Up the Database” task on page 24-2 to preserve existing settings and, if
you will recreate the circuits, record the circuit information.

Step 2

Verify that traffic is no longer carried on the circuit and that the circuit can be safely deleted.

Step 3

Investigate all network alarms and resolve any problems that might be affected by the circuit deletion.

Step 4

From the View menu, choose Go to Network View.

Step 5

Click the Circuits tab.

Step 6

Choose one or more STS or VC circuits from the Type column that you want to delete, then click Delete.

Step 7

In the Delete Circuits confirmation dialog box, complete the following:
•

Change drop port admin state—Check this box if you want to change the administrative state for the
circuit source and destination ports. After checking the box, choose one of the following
administrative states:
– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.
– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in

service.
– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and

disables them.
– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for

maintenance.
•

Note

Step 8

Notify when completed—If checked, the CTC Alerts confirmation dialog box indicates when the
circuit is deleted. During this time, you cannot perform other CTC functions. If you are deleting
many circuits, waiting for confirmation might take a few minutes. Circuits are deleted whether or
not this check box is checked.

The CTC Alerts dialog box will not automatically open to show a deletion error unless you
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see
the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC Alerts
dialog box is not set to open automatically with a notification, the red triangle inside the CTC
Alerts toolbar icon indicates that a notification exists.

Complete one of the following:
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Step 9

•

If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the
information, continue with Step 8. If you do not want to save the information, continue with Step 9.

•

If you did not check Notify when completed, the Circuits page appears. Continue with Step 10.

If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you
do not want to save it, continue with Step 10.
a.

Click Save.

b.

Click Browse and navigate to the directory where you want to save the file.

c.

Type the file name using a TXT file extension, and click OK.

Step 10

Click Close to close the CTC Alerts dialog box.

Step 11

Complete the “NTP-G103 Back Up the Database” task on page 24-2 if you require a backup of your
changes.

Step 12

Return to your originating procedure (NTP).

DLP-G467 Edit an STS or VC Circuit Name
Purpose

This task changes the name of an STS or VC circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab.

Step 3

Click the STS or VC circuit whose name you want to edit, then click Edit. The Edit Circuit dialog box
appears with the General tab displayed.

Step 4

In the Name field, enter the new STS or VC circuit name.

Step 5

Click Apply.

Step 6

Return to your originating procedure (NTP).
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NTP-G150 Upgrade Optical Channel Network Connections to
Optical Channel Client Connections
Purpose

This procedure upgrades OCHNCs created in earlier software releases to
OCHCCs. It also upgrades an OCHNC circuit to an OCH trail circuit
(without the OCHCC circuit) in case the PPCs or internal patchcords
connect to an ADM_10G or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
(only in L2-over-DWDM mode) cards.

Tools/Equipment

None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

During this procedure, the OCHNC is replaced with two circuit types, the OCHCC, which establishes a
connection between the client card client ports, and the OCH trail, which establishes a connection
between the client card trunk ports. The OCH trail is given the same name as the OCHNC. The OCHCC
is given a system-generated name in the format: circuit-type_NE-name::unique sequence number. To
edit the OCHCC circuit name, complete the “DLP-G424 Edit an OCHCC Circuit Name” task on
page 17-28. To edit the OCH trail circuit name, complete the “DLP-G424 Edit an OCHCC Circuit
Name” task on page 17-28.

Note

Multiple OCHCCs might use the same OCH trail. The OCH Wlen (wavelength) parameter on the
Circuits page can be used to determine the OCHCC and OCH trail associations.

Step 1

As needed, identify the OCHCC to be provisioned using the “DLP-G350 Use the Cisco Transport
Planner Traffic Matrix Report” task on page 16-27.

Step 2

Complete the DLP-G46 Log into CTC at a node on the network where you want to upgrade the OCHNCs.
If you are already logged in, continue with Step 3.

Step 3

From the View menu, choose Go to Network View.

Step 4

Click the Circuits tab and find the OCH you want to upgrade.

Step 5

Record the following information:

Step 6

•

OCHNC Wlen (OCHNC wavelength)

•

Source node/shelf (if applicable)/slot/port/side (include both Side A and Side B nodes, if present)

•

Destination node/shelf (if applicable)/slot/port/side (include both Side A and Side B nodes, if
present)

Use the information recorded in Step 5 to complete one of the following
•

DLP-G344 Verify Provisionable and Internal Patchcords, page 17-68—Complete this task if
provisionable patchcords (PPCs) and internal patchcords exist on the network but you are not sure
whether one was created for the OCHNC that you want to upgrade.
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•

NTP-G184 Create a Provisionable Patchcord, page 17-78—Complete this procedure if you know
that PPCs were not created between the OCHNC node and the client node. If you recently upgraded
from a previous release, you must create PPCs between the source client and OCHNC node and
between the destination client and OCHNC node.

Step 7

In network view, click the OCHNC that you want to upgrade.

Step 8

From the Tools menu, choose Circuits > Upgrade OCHNC. If the Upgrade OCHNC Initialization
“Completed” status appears (Figure 17-4), continue with Step 9. If the “Failed” status appears
(Figure 17-5), complete the following substeps:
a.

Click each failure reason to view the failure details. A common cause of initialization failures is the
absence or incorrect completion of PPCs or internal patchcords between the client nodes and the
optical channel (OCH) nodes.

b.

Repeat Steps 3 through 8, verifying that the OCHNC ports and provisionable patchcord (PPC) path
match on both sides. If the upgrade “Failed” status appears again, click Save to save the results to a
local or network computer. (The file can be opened with any text editor.) Then, contact your next
level of support.

Figure 17-4

Upgrade OCHNC Initialization—Completed

151573

Click to display details

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

17-66

78-20702-02

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords
DLP- G467 Edit an STS or VC Circuit Name

Figure 17-5

Upgrade OCHNC Initialization—Failed

151572

Click to display details

Step 9

Click each result to review the details. If you want to save the results, click Save and save the results to
a file on a local or network computer. Click Continue.

Step 10

Review the information in the Upgrade OCHNC dialog box, then click OK.

Step 11

Click Yes in the confirmation dialog box, then click OK on the Completed Upgrade OCHNC wizard
page.

Tip

Step 12

To see all of the information in the Source and Destination table cells, increase the column
widths by clicking and dragging the column heading borders to the right or left.

View the OCHCC and its OCH trail in the Circuits page. For information and procedures for viewing
and editing OCHCC and OCH trails, see the “NTP-G58 Locate and View Optical Channel Circuits”
procedure on page 17-71.
Stop. You have completed this procedure.
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DLP-G344 Verify Provisionable and Internal Patchcords
Purpose

This task verifies the PPCs that are required between client TXP, MXP,
ADM-10G, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP,
100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE, or
ITU-T line cards and OCH DWDM nodes for OCHCCs. This task is not
required for OCHNCs.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Provisioning > Provisionable Patchcords (PPC) tabs.

Step 3

Use one of the following methods to verify that PPCs exist from the client TXP, MXP, ADM-10G,
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP,
AR_XP, AR_XPE, or ITU-T line card node, slot, and port to the DWDM OCH node, slot, port, and
wavelength:
•

Review the Patchcord Terminations table. PPCs should exist from the client TXP, MXP, ADM-10G,
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC,
AR_MXP, AR_XP, or AR_XPE, or ITU-T line card node to the OCH node, slot, and port recorded
in the referring procedure.

•

Review the network graphic. PPCs are represented by a small hand holding a lambda symbol.
Clicking the PPC line on the graphic displays the PPC source and destination nodes, slots, and ports
in the CTC information area. This information should match the node, slot, and port recorded in the
referring procedure.

Step 4

Display the OCHCC source node in node view.

Step 5

Click the Provisioning > WDM-ANS > Internal Patchcords tab.

Step 6

Verify that internal patchcords exist from the source TXP, MXP, GE_XP, 10GE_XP, GE_XPE,
10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, or AR_XPE OCH trunk
port to the OCH filter port. If so, continue with Step 7. If not, complete the “NTP-G242 Create an
Internal Patchcord Manually” task on page 14-112.

Step 7

Display the OCHCC destination node in node view.

Step 8

Click the Provisioning > WDM-ANS > Internal Patchcords tab.

Step 9

Verify that internal patchcords exist from the destination TXP, MXP, GE_XP, 10GE_XP, GE_XPE,
10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE trunk port to
the OCH filter port. If so, you are completed with this task. If not, complete the “NTP-G242 Create an
Internal Patchcord Manually” task on page 14-112.

Step 10

Return to your originating procedure (NTP).
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NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits
Purpose

This procedure checks nodes that are traversed by an OCHNC or OCH trail
circuit to verify that all conditions required for bringing the circuit in
service are in place. If not, the procedure identifies the invalid condition
and provides links to the location in CTC where it can be fixed.

Tools/Equipment

None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45,
or DLP-G395 Create an Optical Channel Trail, page 17-35

Note

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

This procedure cannot be used for OCHCC circuits.
Complete the DLP-G46 Log into CTC at a node on the network where you want to diagnose and fix the
OCHNC or OCH trail circuit. If you are already logged in, continue with Step 2.

Note

Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this
option is checked.

Step 2

From the View menu, choose Go to Network View.

Step 3

Click the Circuits tab.

Step 4

Click the OCHNC or OCH trail that you want to diagnose.

Step 5

Click Edit.

Step 6

In the Edit Circuit dialog box, click the Diagnostic and Fix tab.

Step 7

Click Start. The diagnostic checks all OCHNC or OCH trail node connections and displays the results
in an expandable tree view under the OCH diagnostic heading.

Step 8

Double-click OCH diagnostic to display the diagnostic messages.
•

No problems are found—A “node: No issues found” message appears, where node is the node name
or IP address of an ONS 15454 containing the OCHNC or OCH trail source, destination, or
pass-through connection. If this message appears for all nodes, continue with Step 9.

•

Problems are found—double-click on the nodes with problems and the error messages appear with
a hyperlink labeled Fix or Check. If error messages appear, complete the fixes using the tasks and
procedures listed in Table 17-9.

Note

Only one error per node is displayed. If multiple errors exist, you must fix the first error,
then rerun the diagnostic to display the next error(s).
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Table 17-9

Diagnostic and Fix Errors

Error Message

Description/Fix

Invalid connection state
for “circuit name”:
administrative state

The circuit state is not valid. Click Fix to display the State tab of the
Edit Circuit dialog box where you can change the circuit state using the
“DLP-G419 Change an OCH Trail Administrative State” task on
page 17-40 or the “DLP-G420 Change an OCHNC Administrative State”
task on page 17-53.

Invalid admin state:
administrative state

The state of a port traversed by the circuit is not valid, for example, the port
is in service. Click Fix to display the card view Provisioning tab, where
you can change the port administrative state using the appropriate task for
changing the optical line settings in Chapter 21, “Change DWDM Card
Settings.”

ANS couldn’t regulate the ANS could not be regulated for the port. Click Fix to display the node view
port
Provisioning > WDM-ANS > Port Status tab where you can launch ANS
using the “NTP-G37 Run Automatic Node Setup” task on page 14-126.
APC couldn’t regulate the APC could not be regulated for the port. Click Fix to display the network
port
view Maintenance > APC tab. Double-click the domain to expand the
view. Right-click the node/side and choose the end you want to view. APC
information is displayed on the right side. Read any message that might
explain the failure, or restart APC by completing the DLP-G158 Enable
Automatic Power Control.
APC regulation is running Indicates that APC regulation is running and must be allowed to finish.
Click Check to display the node view Maintenance > DWDM > APC tab
where you can monitor the APC regulation.
APC is not enabled for
this side.

Step 9

Step 10

APC is not enabled on an ONS 15454 side. Click Fix to display the
network view Maintenance > APC tab where you can enable APC using
the DLP-G158 Enable Automatic Power Control.

If you want to save the diagnostic results to a text file, complete the following steps. If not, continue with
Step 10.
a.

Click Save.

b.

In the Save Diagnostic and Fix to File dialog box, enter the local directory and file name, or click
Browse to navigate to a directory where you want to save the file.

c.

Click OK.

Repeat Steps 7 through 9 until “No issues found” appears for all nodes traversed by the OCHNC or
OCH trail circuit.
Stop. You have completed this procedure.
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NTP-G58 Locate and View Optical Channel Circuits
Purpose

This procedure allows you to locate and view OCHNC, OCHCC and OCH
trail circuits. You can also export circuit data into a text file.

Tools/Equipment

None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45
DLP-G346 Provision Optical Channel Client Connections, page 17-18

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Complete the DLP-G46 Log into CTC at a node on the network where you want to view the circuits. If
you are already logged in, continue with Step 2.

Note

Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this
option is checked.

Step 2

As needed, complete the “DLP-G100 Search for Optical Channel Circuits” task on page 17-71.

Step 3

As needed, complete the “DLP-G101 View Optical Channel Circuit Information” task on page 17-72.

Step 4

As needed, complete the “DLP-G102 Filter the Display of Optical Channel Circuits” task on page 17-75.

Step 5

As needed, complete the “DLP-G103 View Optical Channel Circuits on a Span” task on page 17-77.

Step 6

As needed, complete the DLP-G114 Export CTC Data.
Stop. You have completed this procedure.

DLP-G100 Search for Optical Channel Circuits
Purpose

This task searches for OCHNC, OCHCC, OCH trail, and ONS 15454
circuits at the network, node, or card level.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Navigate to the appropriate CTC view:
•

To search the entire network, from the View menu choose Go to Network View.

•

To search for circuits that originate, terminate, or pass through a specific node, from the View menu
choose Go to Other Node, then choose the node you want to search and click OK.
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•

To search for circuits that originate, terminate, or pass through a specific card, double-click the card
on the shelf graphic in node view (single-shelf mode) or shelf view (multishelf mode) to open the
card in card view.

Step 2

Click the Circuits tab.

Step 3

If you are in node or card view, choose the scope for the search, Node or Network (All), in the Scope
drop-down list located at the bottom right side of the screen. Choose Node to see all of the circuits on
that node, or choose Network (All) to see all circuits in the network.

Step 4

Click Search if you need to search through the list of circuits.

Step 5

In the Circuit Name Search dialog box, complete the following:
•

Find What—Enter the text of the circuit name you want to find. This field is not case-sensitive.

•

Match whole word only—Check this check box to instruct CTC to select circuits only if the entire
word matches the text in the Find What field.

•

Match case—Check this check box to instruct CTC to select circuits only when the capitalization
matches the capitalization entered in the Find What field.

•

Direction—Choose the direction for the search. Searches are conducted up or down from the
currently selected circuit.

Step 6

Click Find Next. If a match is found the circuit will be highlighted in the Circuits page. To continue the
search, click Find Next again to find the next circuit.

Step 7

Repeat Steps 5 and 6 until you are finished, then click Cancel.

Step 8

Return to your originating procedure (NTP).

DLP-G101 View Optical Channel Circuit Information
Purpose

This task provides information about OCHNC, OCHCC, OCH trail, and
ONS 15454 circuits.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Navigate to the appropriate CTC view:
•

To view circuits for an entire network, from the View menu choose Go to Network View.

•

To view circuits that originate, terminate, or pass through a specific node, from the View menu
choose Go to Other Node, then choose the node you want to search and click OK.

•

To view circuits that originate, terminate, or pass through a specific card, in node view (single-shelf
mode) or shelf view (multishelf mode), double-click the card containing the circuits you want to
view.
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Note

Step 2

In node or card view, you can change the scope of the circuits that appear by choosing Card
(in card view), Node, or Network from the Scope drop-down list in the bottom right corner
of the Circuits page.

Click the Circuits tab. The Circuits tab shows the following information:

Note

The following order is the default column sequence, the order might be different on your screen,
depending on your individual CTC setup.

•

Circuit Name—Name of the circuit. The circuit name can be manually assigned or automatically
generated.

•

Type—OCHNC, OCHCC, or OCH-Trail.

Note

•

The following circuit types are not applicable to DWDM nodes: STS, VT, VTT (VT tunnel),
VAP (VT aggregation point), STS-v (STS VCAT circuit), VT-v (VT VCAT circuit), HOP
(high-order circuit), LOP (low-order circuit), VCT (VC low-order tunnel), and VCA
(low-order VCAT circuit).

Size—Circuit size. OCHNC, OCHCC, and OCH-Trail sizes are Equipped not specific, Multi-rate,
2.5 Gbps No FEC, 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC.

Note

The following circuit types under the circuit size column are not applicable to DWDM
nodes: STS, VT, VCAT, VC12, VC11, VC3, and VC4.

•

OCHNC Wlen—The wavelength provisioned for the OCHNC, OCHCC, or OCH trail. See
Table 17-6 on page 17-20 for a list of channels and wavelengths.

•

Dir—The circuit direction, either two-way or one-way.

•

Protection—The type of circuit protection. See Table 17-10 on page 17-74 for a list of protection
types.

•

Status—The circuit status. See Table 17-11 on page 17-74 for a list of circuit statuses.

•

Source—The circuit source in the format: node/slot/port “port name”. The port name will appear
in quotes only if a name was assigned to it. (To assign names to ports, see the “DLP-G104 Assign a
Name to a Port” task on page 17-16.)

•

Destination—The circuit destination in the format: node/slot/port “port name”. The port name will
appear in quotes only if a name was assigned to it. (To assign names to ports, see the “DLP-G104
Assign a Name to a Port” task on page 17-16.)

•

# of VLANS—The number of VLANs used by an Ethernet circuit. VLANs are not applicable to
DWDM nodes.

•

# of Spans—The number of internode links that constitute the circuit. Right-clicking the column
title shows a shortcut menu from which you can choose Span Details to show or hide circuit span
detail.
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•

State—The circuit service state, which is an aggregate of the service states of its cross-connects. For
ANSI shelves, the service state is IS, OOS, or OOS-PARTIAL. For ETSI shelves, the service state
is Unlocked, Locked, or Locked-partial. For more information about ANSI and ETSI service states,
see the Administrative and Service States document.
– IS/Unlocked—All cross-connects are in service and operational.
– OOS/Locked—For ANSI, all cross-connects are OOS-MA,MT and/or OOS-MA,DSBLD. For

ETSI, all cross-connects are Locked-enabled,maintenance and/or Locked-enabled,disabled.
– OOS-PARTIAL/Locked-partial—At least one cross-connect is IS-NR (ANSI) or

Unlocked-enabled (ETSI) and others are out-of-service.

Note

Right-clicking a column title (Circuit name, Type, etc.) opens a shortcut menu that allows
you to show or hide circuit details.

•

Acpt Threshold—The optical validation acceptance threshold value set for the GMPLS circuit. For
more information on the threshold values, see the “12.10.1.2 Acceptance Thresholds” section on
page 12-110.

•

Opt Val—The optical validation result for the GMPLS circuit. For more information on the optical
validation values, see the “12.10.1.3 Validation Modes” section on page 12-110.

Table 17-10

Circuit Protection Types

Protection Type

Description

Y-cable

(OCHNC and OCH-Trail circuit types only) The circuit is protected by a
transponder or muxponder card Y-cable protection group.

Splitter

The circuit is protected by the protect transponder splitter protection.

Unprot

A circuit with a source and destination on different nodes is not protected.

N/A

A circuit with connections on the same node is not protected.

Unknown

A circuit has a source and destination on different nodes and communication
is down between the nodes. This protection type appears if not all circuit
components are known.

Table 17-11

Cisco ONS 15454 Circuit Status

Status

Definition/Activity

CREATING

CTC is creating a circuit.

DISCOVERED

CTC created a circuit. All components are in place and a complete path exists
from the circuit source to the circuit destination.

DELETING

CTC is deleting a circuit.
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Table 17-11

Cisco ONS 15454 Circuit Status (continued)

Status

Definition/Activity

PARTIAL

A CTC-created circuit is missing a cross-connect or network span, a complete
path from source to destination(s) does not exist, or an alarm interface panel
(AIP) change occurred on one of the circuit nodes and the circuit is in need
of repair. (AIPs store the node MAC address.)
In CTC, circuits are represented using cross-connects and network spans. If a
network span is missing from a circuit, the circuit status is PARTIAL.
However, a PARTIAL status does not necessarily mean that a circuit traffic
failure has occurred, because traffic might flow on a protect path.
Network spans are in one of two states: up or down. On CTC circuit and
network maps, up spans are shown as green lines, and down spans are shown
as gray lines. If a failure occurs on a network span during a CTC session, the
span remains on the network map but its color changes to gray to indicate the
span is down. If you restart your CTC session while the failure is active, the
new CTC session cannot discover the span and its span line will not appear
on the network map.
Subsequently, circuits routed on a network span that goes down will appear
as DISCOVERED during the current CTC session, but they will appear as
PARTIAL to users who log in after the span failure.
This status does not appear for OCHNC circuit types.

DISCOVERED_TL1

A TL1-created circuit or a TL1-like CTC-created circuit is complete. A
complete path from source to destination(s) exists.
This status does not appear for OCHNC circuit types.

PARTIAL_TL1

A TL1-created circuit or a TL1-like CTC-created circuit is missing a
cross-connect, and a complete path from source to destination(s) does not
exist.
This status does not appear for OCHNC circuit types.

Step 3

Return to your originating procedure (NTP).

DLP-G102 Filter the Display of Optical Channel Circuits
Purpose

This task filters the display of OCHNCs, OCHCCs, OCH trails and
SONET or SDH circuits in the Circuits page. You can filter the circuits in
network, node, or card view based on circuit or OCHNC name, size, type,
direction, and other attributes.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher
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Step 1

Navigate to the appropriate CTC view:
•

To filter network circuits, from the View menu choose Go to Network View.

•

To filter circuits that originate, terminate, or pass through a specific node, from the View menu
choose Go to Other Node, then choose the node you want to search and click OK.

•

To filter circuits that originate, terminate, or pass through a specific card, double-click the card on
the shelf graphic in node view (single-shelf mode) or shelf view (multishelf mode) to open the card
in card view.

Step 2

Click the Circuits tab.

Step 3

Set the attributes for filtering the circuit display:
a.

Click the Filter button.

b.

In the General tab of the Circuit Filter dialog box, set the following filter attributes, as necessary:
•

Name—Enter a complete or partial circuit name to filter circuits based on the circuit name.

•

Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way
circuits), or 2-way (display only two-way circuits).

•

OCHNC Wlen—(DWDM OCHNCs only) Choose an OCHNC wavelength to filter the circuits.
For example, choosing 1530.33 will display channels provisioned on the 1530.33-nm
wavelength.

•

Status—Choose one: Any (status not used to filter circuits) or Discovered (display only
discovered circuits). Other statuses do not apply to OCHNCs.

•

State—Choose one: OOS (ANSI) or Locked (ETSI) to display only out-of-service circuits,
IS (ANSI) or Unlocked (ETSI) to display only in-service circuits (OCHNCs have IS/Unlocked
states only), or OOS-PARTIAL (ANSI) or Locked-partial (ETSI) to display only circuits with
cross-connects in mixed service states.

•

Protection—Enter the circuit protection type to filter circuits based on their protection.

•

Shelf—(multishelf nodes only) Enter the shelf name to filter circuits based on that shelf.

•

Slot—Enter a slot number to filter circuits based on the source or destination slot.

•

Port—Enter a port number to filter circuits based on the source or destination port.

•

Type—Choose one: Any (type not used to filter circuits), OCHNC (displays only OCHNCs),
OCHCC (displays only OCHCCs), or OCH-Trail (displays only OCH trail circuits).

Note

•

Note

The following circuit types are not applicable to DWDM nodes: STS, VT, VT Tunnel,
STS-V, VT-V, and VT Aggregation Point, VC_HO_PATH_CIRCUIT,
VC_LO_PATH_CIRCUIT, VC_LO_PATH_TUNNEL, VC_LO_PATH_AGGREGATION,
VC_HO_PATH_VCAT_CIRCUIT, and VC_LO_PATH_VCAT_CIRCUIT.
Size—Click the appropriate check boxes to filter circuits based on size. The following sizes are
available, depending on the circuit type: Multi-rate, Equipment non specific, 2.5 Gbps FEC,
2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC.

VT1.5, STS-1, STS3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, and STS-192c are not
applicable to ANSI DWDM nodes. VC12, VC3, VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c,
VC4-8c, VC4-9c, VC4-16c, and VC4-64 are not applicable to ETSI DWDM nodes.
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The check boxes shown depend on the Type field selection. If you chose Any, all sizes are
available. If you chose OCHNC as the circuit type, only Multi-rate, Equipment non specific,
2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC appear. If you choose
OCHCC, only OCHCC is available. If you choose OCH Trail, only Equipment non specific is
available.
Step 4

To set the filter for the ring, node, link, and source and drop types, click the Advanced tab and complete
the following substeps. If you do not want to make advanced filter selections, continue with Step 5.
a.

If you made selections on the General tab, click Yes in the confirmation box to apply the settings.

b.

In the Advanced tab of the Circuit Filter dialog box, set the following filter attributes as necessary:
•

Ring—Choose the ring from the drop-down list.

•

Node—Click the check boxes by each node in the network to filter circuits based on node.

•

Link—Choose a link in the network.

•

Source/Drop—Choose one of the following to filter circuits based on whether they have single
or multiple sources and drops: One Source and One Drop Only or Multiple Sources or
Multiple Drops.

Step 5

Click OK. Circuits matching the attributes in the Filter Circuits dialog box appear in the Circuits page.

Step 6

To turn filtering off, click the Filter icon in the lower right corner of the Circuits page. Click the icon
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 7

Return to your originating procedure (NTP).

DLP-G103 View Optical Channel Circuits on a Span
Purpose

This task allows you to view OCHNCs, OCHCCs, and OCH trails on an
ONS 15454 span.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

In node view (single-shelf mode) or multishelf view (multishelf mode), from the View menu choose
Go to Network View. If you are already in network view, continue with Step 2.

Step 2

Right-click the green line between the nodes containing the circuits that you want to view and choose
Circuits to view OCHNCs, OCHCCs, or unprotected circuits on the span.

Step 3

In the Circuits on Span dialog box, view information about the circuits that traverse the span. The
information that appears depends on the circuit type. For OCHNCs, the following information appears:
•

Type—The type of circuit: OCHNC, OCHCC, or OCH-Trail.

•

Size—The circuit size.

•

OCHNC Wavelength—The wavelength provisioned for the OCHNC.

•

DIR—2-way or 1-way.
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Step 4

•

Circuit—The OCHNC circuit name.

•

OCHNC Dir—The direction provisioned for the OCHNC, either Side B to Side A or Side A to
Side B.

Return to your originating procedure (NTP).

NTP-G184 Create a Provisionable Patchcord
Purpose

This procedure creates a provisionable patchcord (PPC), also called a
virtual link. Four types of PPCs can be created:
•

Client/Trunk to Client/Trunk (L2)

•

Client/Trunk to Client/Trunk

•

Side to Side (OTS)

•

OCH-Trunk to OCH-Filter

PPCs create a virtual connection between the OCH and the client nodes.
(PPCs are not required for OCHNCs.)
Tools/Equipment

OC-N, TXP, MXP, OADM, ROADM, multiplexer (MUX), and
demultiplexer (DMX) cards

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

If a Side-to-Side PPC is created between nodes, it will no longer function if the node Security Mode
mode is enabled (see “DLP-G264 Enable Node Security Mode” task on page 14-25). If the Secure mode
is enabled, the DCN extension feature is unable to use the LAN interface to extend the internal network
(due to the network isolation in this configuration mode). The result is that the topology discovery on
the Side-to-Side PPC no longer operates.

Note

This task requires data communications channel (DCC) or generic communications channel (GCC)
connectivity between the OCH node and the subtended TXP, MXP, or ITU-T line card client shelves.

Note

An optical port requires two patchcords when the remote end is Y-cable protected, or is an add/drop
multiplexer, or multiplexer/demultiplexer port.

Note

This procedure automatically turns on any OPT-RAMP-C or OPT-RAMP-CE cards installed.

Step 1

Complete the following tasks, as needed, to verify the cabling between the TXP/MXP/line cards in the
client node and the OCH cards in the DWDM node:
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Step 2

•

DLP-G349 Use the Cisco Transport Planner Internal Connections Report, page 14-78

•

DLP-G350 Use the Cisco Transport Planner Traffic Matrix Report, page 16-27

In the node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Comm Channels > PPC tabs. Alternatively, in network view, click the Provisioning > Provisionable
Patchcord (PPC) tabs.
PPCs can be created in either node or network view. However, if you create the PPC in node view, the
PPC origination ports will be restricted to the cards installed on the node. Therefore, choose node view
only if you know that the PPC origination port resides on a card installed in the node.

You can create OTS-to-OTS PPC only in the network view.

Note
Step 3

Click Create. The PPC Attributes page of the PPC Creation wizard appears.

Step 4

Choose one of the following PPC link types. Table 17-2 provides a list of ports that serve as PPC
endpoints for each option. However, if Cisco 7600 node is used as the client node, then choose only the
OCH-Trunk to OCH-Filter link type.
•

Client/Trunk to Client/Trunk (L2)—Creates a PPC between two NNI client or trunk ports on
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE cards provisioned in L2-over-DWDM mode.

•

Client/Trunk to Client/Trunk—Creates a PPC between two optical channel trunk ports on TXP,
MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, or ITU-T line cards.

•

Side to Side (OTS)—Creates a PPC between two OTS (optical transport section) ports that belong
to a Side. This option establishes DCN connectivity between nodes that do not have OSCM or
OSC-CSM cards installed or TNC OSC provisioned and therefore do not have OSC connectivity.
CTC selects the OTS ports after you choose the origination and termination sides.

•

OCH-Trunk to OCH-Filter—Creates a PPC between an optical channel trunk port on a TXP, MXP,
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, or ITU-T line card, or
Cisco 7600 series node and an optical channel filter port on a MUX, DMX, or WSS card; or
ADD/DROP port of a 15216-FLD-4, or 15216-MD-40-EVEN, 15216-EF-40-EVEN,
15216-MD-48-EVEN, 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD passive
module.

Table 17-12

Provisionable Patchcord Ports

Card

Client/Trunk (L2) Port

GE_XP

Client or trunk port in Any trunk port
NNI mode

—

—

—

—

—

10GE_XP

Client/Trunk Port OTS Port

OCH Filter Port

GE_XPE
10GE_XPE
TXP

Any trunk port

MXP
ADM-10G
OTU2_XP
ITU-T
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Table 17-12

Provisionable Patchcord Ports (continued)

Card

Client/Trunk (L2) Port

Client/Trunk Port OTS Port

OCH Filter Port

OPT-BST

—

—

—

LINE RX
LINE TX

OPT-BST-E
OPT-BST-L
OPT-AMP-17-C

—

—

COM RX1

—

1

OPT-AMP-C

COM TX

OPT-AMP-L

LINE RX2
LINE TX2

OPT-PRE

—

—

COM RX3
COM TX

OPT-RAMP-C

—

—

—

3

LINE RX

—

LINE TX

OPT-RAMP-CE
15454-M-RAMAN-CTP
15454-M-RAMAN-COP
40-SMR1-C

—

—

40-SMR2-C
32MUX

LINE RX

—

LINE TX
—

—

—

Any CHAN
RX port

—

—

—

Any CHAN
TX port

—

—

—

Any ADD port

—

—

COM RX

—

32MUX-O
40-MUX-C
32DMX
32DMX-L
32DMX-O
40-DMX-C
40-DMX-CE
32WSS
32WSS-L
40-WSS-C
40-WSS-CE
40-WXC-C

COM TX
80-WXC-C

—

—

EAD(i), i=1 to
8

—

COM
AD
COM RX
DROP TX
EXP TX
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Table 17-12

Provisionable Patchcord Ports (continued)

Card

Client/Trunk (L2) Port

Client/Trunk Port OTS Port

OCH Filter Port

MMU

—

—

—

EXP A RX
EXP A TX

40-SMR2-C

—

—

—

ADD-RX
DROP-RX
EXP-TX
EXPi-RX

40-SMR1-C

—

—

—

ADD-RX
DROP-RX
EXP-TX
EXP-RX
LINE-RX
LINE-TX

TDC-CC

—

—

—

TDC-FC
XT-40G

DC-RX
DC-TX

—

Any trunk port

—

—

—

—

—

Any CHAN
RX/TX port

—

—

—

Any CHAN
RX/TX port

—

—

—

Any CHAN
RX/TX port

—

—

—

Any CHAN
RX/TX port

XM-40G
XM-40G-CE
XT-40G-CE
15216-MD-40-ODD
15216-MD-40-EVEN
15216-EF-40-ODD
15216-EF-40-EVEN
15216-MD-48-ODD
15216-MD-48-EVEN
15216-FLD-4

1. When Card Mode is OPT-PRET.
2. When Card Mode is OPT-LINE.
3. Line nodes with two OPT-PRE cards and no BST cards installed.

Step 5

If you chose Client/Trunk to Client/Trunk or OCH-Trunk to OCH-Filter in Step 4, complete the
following fields. If you chose Client/Trunk to Client/Trunk (L2) or Side to Side (OTS) (in Step 4,
continue with Step 6.
•

OCHNC Wavelength—(OCH Trunk to OCH Filter only) From the drop-down lists, choose the
wavelength band (C or L), wavelength number type (Odd or Even), and then the wavelength.
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Same wavelengths must be set at both the ends of a virtual link (Cisco 7600 node and the DWDM
node). This wavelength must be set on the Cisco 7600 series router port on which the PPC or
virtual link is configured.

Note

•

Protected—Check this box if you want only protected cards and ports to appear as options in the
OCHNC origination and termination pages.

Step 6

Click Next.

Step 7

In the PPC Origination page, complete the fields shown in Table 17-13. The table columns indicate
whether the field is provisionable based on the option chosen in Step 4.
Table 17-13

PPC Origination Fields

Client/Trunk to
Client/Trunk(L2)

Client/Trunk to
Client/Trunk

OCH-Trunk to
OCH-Filter

Side to
Side (OTS)

Choose the node
where the PPC will
originate.

Yes

Yes

Yes

Yes

(IPoDWDM using
Cisco 7600) Choose
the DWDM node as
the PPC termination
node.

No

No

Yes

No

Side

Choose the side
where the PPC will
originate.

No

No

No

Yes

Shelf

(Multishelf only)
Choose the shelf
where the PPC will
originate.

Yes

Yes

Yes

Yes

Slot

Choose the slot
where the PPC will
originate.

Yes

Yes

Yes

Yes

Port

Choose the port
where the PPC will
originate.

Yes

Yes

Yes

No

Tx Port

(Display only) The
OTS TX port where
the PPC will
originate.

No

No

No

Yes

Rx Port

Choose the RX port
where the PPC will
originate.

No

No

No

Yes

Protection (Display only)
Displays the
protection option
chosen in Step 5, if
applicable.

No

Yes

Yes

No

Field

Description

Node
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Table 17-13

PPC Origination Fields (continued)

Client/Trunk to
Client/Trunk(L2)

Client/Trunk to
Client/Trunk

OCH-Trunk to
OCH-Filter

Side to
Side (OTS)

Yes

Yes

No

No

Tx ID

Displays the transmit No
ID automatically
assigned to the PPC.

No

Yes

Yes

Rx ID

Displays the receive
ID automatically
assigned to the PPC.

No

Yes

Yes

Field

Description

ID

Displays the ID
automatically
assigned to the PPC.

No

Step 8

Click Next. If you chose Client/Trunk to Client/Trunk or OCH Trunk to OCH Filter with the Protected
option in Step 4, continue with Step 9. If not, continue with Step 11.

Step 9

In the PPC Protect Termination page, provision the ID fields. If you chose OCH Trunk to OCH Trunk in
Step 4, one ID field is available. If you chose OCH Trunk to OCH Filter in Step 4, two ID fields are
available, Rx ID and Tx ID.

Step 10

Click Next.

Step 11

In the PPC Termination page, complete the fields shown in Table 17-14. The OCH Trunk to OCH Trunk,
OCH Trunk to OCH Filter, and Side to Side (OTS) columns indicate whether the field is provisionable.
Table 17-14

PPC Termination Fields

Client/Trunk to
Client/Trunk (L2)

Client/Trunk
to
Client/Trunk

Side to
OCH Trunk to Side
OCH Filter
(OTS)

Field

Description

Node

Choose the node where the Yes
PPC will terminate.

Yes

Yes

Yes

No

No

Yes

No

Side

Choose the side where the No
PPC will terminate.

No

No

Yes

Shelf

(Multishelf only) Choose
the shelf where the PPC
will terminate.

Yes

Yes

Yes

Yes

Slot

Choose the slot where the
PPC will terminate.

Yes

Yes

Yes

Yes

Port

Choose the port where the Yes
PPC will terminate.

Yes

No

No

Tx Port

Choose the TX port where No
the PPC will terminate.

No

Yes

Yes

Rx Port

Choose the RX port where No
the PPC will terminate.

No

Yes

Yes

(IPoDWDM using
Cisco 7600) Choose the
DWDM node as the PPC
termination node.
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Table 17-14

PPC Termination Fields (continued)

Client/Trunk to
Client/Trunk (L2)

Client/Trunk
to
Client/Trunk

Side to
OCH Trunk to Side
OCH Filter
(OTS)

Protection (Display only) Displays
the protection option
chosen in Step 5, if
applicable.

No

Yes

No

No

ID

Displays the ID
automatically assigned to
the PPC.

Yes

Yes

No

No

Rx ID

Displays the receive ID
automatically assigned to
the PPC.

No

No

Yes

Yes

Tx ID

Displays the transmit ID
automatically assigned to
the PPC.

No

No

Yes

Yes

Field

Description

Step 12

Click Next. If you chose Client/Trunk to Client/Trunk or OCH Trunk to OCH Filter with the Protected
option in Step 4, continue with Step 13. If not, continue with Step 14.

Step 13

In the PPC Protect Termination page, provision the ID fields. If you chose Client/Trunk to Client/Trunk
in Step 4, one ID field is available. If you chose OCH Trunk to OCH Filter in Step 4, two ID fields are
available, Rx ID and Tx ID.

Step 14

In the PPCs ID page, review the PPC information. If the PPC information is correct, click Finish. If you
need to make corrections, click Back and return to the wizard page where you want to change the
information.
Stop. You have completed this procedure.

NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card SVLAN Databases
Purpose

This procedure creates a service provider VLAN (SVLAN) database for
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards provisioned in
L2-over-DWDM mode. The procedure stores newly created SVLANs in
the card (each card has its own SVLAN DB). It also loads and merges
SVLAN databases into the VLAN DB tab where they can be edited.

Tools/Equipment

OC-N, TXP, MXP, OADM, ROADM, multiplexer (MUX), and
demultiplexer (DMX) cards

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher
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Step 1

Complete the DLP-G46 Log into CTC at the node on the network where you will manage the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE SVLAN databases.

Step 2

As needed, complete the following tasks:
•

DLP-G421 Create and Store an SVLAN Database, page 17-85

•

DLP-G382 Add and Remove SVLANS to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE NNI
Ports, page 11-418

•

DLP-G422 Load or Merge an SVLAN Database, page 17-86

Stop. You have completed this procedure.

DLP-G421 Create and Store an SVLAN Database
Purpose

This task creates an SVLAN for a network of GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards provisioned in L2-over-DWDM mode. It then stores
the SVLAN database on the card and not on the node.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Provisioning > SVLAN > SVLAN DB tabs.

Step 3

In the box next to the Add row(s) button, enter the number of SVLANs you want to create.

Step 4

Click Add row(s).

Step 5

For each SVLAN row, enter the following:
•

SVLAN ID—Enter the SVLAN ID. The range is 1 to 4093 with the following restrictions:
– 0 indicates an untagged frame.
– The database can contain a maximum of 4092 unprotected SVLANS. However, it can contain a

maximum of 1024 protected SVLANs.
•

SVLAN Name—Enter the SVLAN name. It can be up to 32 alphanumeric characters.

•

Protection—If this is a protected SVLAN, check the Protection check box. A maximum of 1024
SVLANs can be protected.

•

MAC Learning—Enables or disables MAC learning for the port. MAC learning is used by Layer 2
switches to learn the MAC addresses of network nodes so they know where to send traffic. Layer 2
switches including the GE_XP and 10GE_XP cards in L2-over-DWDM mode maintain a MAC
learning table that associates the MAC addresses and VLANs with a given port.

Note

MAC address table aging is 300 seconds. It cannot be changed. To set this option, the card mode
must be L2-over-DWDM.
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•

IGMP—Enables or disables the Internet Group Management Protocol (IGMP). By default, IGMP is
disabled.

•

IGMP Fast Leave—Enables or disables the IGMP fast leave. By default, IGMP fast leave is disabled.

•

IGMP Suppression—Enables or disables the IGMP report suppression. By default, IGMP
Suppression is disabled.

Step 6

Click Store.

Step 7

In the Store SVLAN DB dialog box, choose one of the following:
•

To Node(s)—Stores the SVLAN database in one or more network nodes. Choose the network nodes
where you want to store the SVLAN database.

•

Shelf—Appears only when the node is provisioned as a multishelf. Choose the shelf where you want
to store the SVLAN database.

•

Slot—Choose the slot containing the card where the SVLAN database is stored. To choose more
than one slot, press the Shift key, or click Select All.

•

To File—Stores the SVLAN database in a file. Enter a file name, then click Browse to navigate to
a local or network drive where you want to store the file.

Step 8

Click OK.

Step 9

Return to your originating procedure (NTP).

DLP-G422 Load or Merge an SVLAN Database
Purpose

This task loads or merges an SVLAN database stored on the card or local
file into the VLAN DB tab on the CTC network view.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Provisioning > SVLAN > SVLAN DB tabs.

Step 3

Click one of the following:

Step 4

•

Load—Loads an SVLAN database from the card or local file and replaces any SVLANs that are in
the network view VLAN DB table.

•

Merge—Loads a SVLAN database from the card or local file, but does not replace any SVLANs
that are in the network view VLAN DB table. The loaded database is merged with any SVLANs that
might be in the table.

In the Load SVLAN DB dialog box, choose one of the following:
•

From Node—Loads the SVLAN database from the card. Choose the card where you want to load
the SVLAN database.
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•

Shelf—Appears only when the node is provisioned as a multishelf. Choose the shelf where you want
to load the SVLAN database.

•

Slot—Choose the slot containing the card where you want to load the SVLAN database from.

•

From File—Loads the SVLAN database from a file. Enter the file path in the blank field, or click
Browse to navigate to a local or network directory containing the database file.

Step 5

Click OK.

Step 6

Return to your originating procedure (NTP).

NTP-G60 Create and Delete Overhead Circuits
Purpose

This procedure creates overhead circuits on an ONS 15454 network.
Overhead circuits include ITU-T GCCs, the AIC-I card orderwire, and the
AIC-I card UDC.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1

Complete the DLP-G46 Log into CTC at the node where you will create the overhead circuit. If you are
already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 17-88.

Step 3

As needed, complete the “DLP-G97 Provision a Proxy Tunnel” task on page 17-90.

Step 4

As needed, complete the “DLP-G98 Provision a Firewall Tunnel” task on page 17-91.

Step 5

As needed, complete the “DLP-G109 Provision Orderwire” task on page 17-92.

Step 6

As needed, complete the “DLP-G110 Create a User Data Channel Circuit” task on page 17-94.

Step 7

As needed, complete the “DLP-G112 Delete Overhead Circuits” task on page 17-95.
Stop. You have completed this procedure.
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DLP-G76 Provision DCC/GCC Terminations
Purpose

This task creates the DWDM DCC/GCC terminations required for network
setup when using the TXP, MXP, and XP cards. Perform this task before
you create OCHCC or OCHNC circuits for these cards. In this task, you
can also set up the node so that it has direct IP access to a far-end non-ONS
node over the DCC/GCC network.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

For the OTU2_XP card, you can provision the GCC on any ITU-T G.709-enabled port in Transponder
card configuration and on any port in Standard Regen or Enhanced FEC card configuration. The
OTU2_XP card supports a maximum of three GCC terminations (on port 3, port 4, and either port 1 or
2) at a time.

Note

The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1

If you are provisioning DCC termination on the TXP and MXP card, set the termination mode of the card
as appropriate. See the “G.37 Termination Modes” section on page G-36 for details.

Step 2

If you are provisioning DCC termination, ensure that the OTN is disabled on OTN interfaces (usually
trunk ports). If OTN is enabled, provision GCC instead of DCC termination. For more information about
managing OTN setting on the card, see the “11.25 Procedures for Transponder and Muxponder Cards”
section on page 11-163.

Step 3

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Comm Channels > GCC tabs.

Step 4

Select the DCC or GCC tabs as necessary. Available tabs are:
•

Note

•

GCC (both ANSI and ETSI)

For AR_MXP, AR_XP, and AR_XPE cards, GCC goes down after changing the trunk state to
IS,AINS (ANSI) or Unlocked,automaticInService (ETSI). The GCC comes up when the trunk
state changes to IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) after the specified
soak time.
DCC
– SDCC and LDCC (for ANSI)
– RS-DCC and MS-DCC (for ETSI)

Step 5

Click the Create button. The Create Terminations dialog box appears.
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Step 6

Select the ports where you want to create the DCC/GCC termination. To select more than one port, press
the Shift key or the Ctrl key.

Step 7

Under Port Admin State area, select one of the following:

Step 8

•

Leave unchanged—Does not change the DCC/GCC termination port administrative state.

•

Set to IS or Set to Unlocked —Puts the DCC/GCC termination port in service.

•

Set OOS,DSLBD to IS,AINS (for ANSI) or Set Locked,disabled to
Unlocked,automaticInService (for ETSI)—Changes a port that is currently out of service or locked
to automatic in service.

•

Set OOS,DSLBD to OOS,MT (for ANSI) or Set Locked,disabled to Locked,maintenance (for
ETSI)—Changes a port that is currently out of service or locked to out of service for maintenance.

For GCC termination, the GCC Rate is set as 192 kbps by default. For AR_MXP, AR_XP, and AR_XPE
cards provisioned on 15454 ONS M6 and 15454 ONS M2 shelves, the GCC rate can be set to 400 kbps
and 1200 kbps for OTU1 and OTU2 ports respectively. For 10x10G-LC cards, the GCC rate can be set
to 400 kbps for OTU2 ports. For 100G-LC-C cards, the GCC rate can be set to 400 kbps and 1200 kbps
for OTU4 and trunk ports. For CFP-LC cards, the GCC rate can be set to 400 kbps and 1200 kbps on the
OTU3 virtual port of the peer 100G-LC-C card.

Note

Ensure that the same GCC rate is configured at both ends of a GCC channel.

Step 9

Verify that the Disable OSPF on Link is unchecked. If this check box is checked, node discovery through
the link termination will not happen.

Step 10

If the DCC/GCC termination includes a non-ONS node, check the Far End is Foreign check box. This
automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be specified
by the far end. To change the default to a specific IP address, see the DLP-G184 Change a GCC
Termination.

Step 11

In the Layer 3 area, perform one of the following options:

Step 12

•

Check the IP box only if the DCC/GCC is between the ONS 15454 and another ONS node and only
ONS nodes reside on the network. The DCC/GCC will use Point-to-Point Protocol (PPP).

•

Check both the IP box and the OSI box if the DCC/GCC is between the ONS 15454 and another
ONS node, and third-party NEs that use the OSI protocol stack are on the same network. The
DCC/GCC will use PPP.

If you checked OSI, complete the following substeps. If you checked IP only, continue with Step 13.
a.

Click Next.

b.

Provision the following fields:
– Router—Choose the OSI router.
– ESH—Sets the End System Hello (ESH) propagation frequency. End system (ES) NEs transmit

ESHs to inform other ESs and intermediate systems (ISs) about the Network Service Access
Points (NSAPs) that the ES NEs serve. The default is 10 seconds. The range is 10 to 1000
seconds.
– ISH—Sets the Intermediate System Hello (ISH) protocol data unit (PDU) propagation

frequency. IS NEs send ISHs to other ESs and ISs to inform them about the IS NEs that the IS
NEs serve. The default is 10 seconds. The range is 10 to 1000 seconds.
– IIH—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation

frequency. The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default
is 3 seconds. The range is 1 to 600 seconds.
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– IS-IS Cost—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the

cost to calculate the shortest routing path. The default metric cost for LAN subnets is 60. The
cost normally should not be changed.
Step 13

Step 14

Click Finish. The following alarms appear until all the network DCC/GCC terminations are created and
the ports are in service:
•

GCC-EOC for GCC termination

•

EOC for SDCC termination

•

EOC-L for LDCC termination

Return to your originating procedure (NTP).

DLP-G97 Provision a Proxy Tunnel
Purpose

This task sets up a proxy tunnel to communicate with a non-ONS far-end
node. Proxy tunnels are only necessary when the proxy server is enabled
and a foreign GCC termination exists, or if static routes exist so that the
GCC network is used to access remote networks or devices. You can
provision a maximum of 12 proxy server tunnels.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G76 Provision DCC/GCC Terminations, page 17-88

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser only

If the proxy server is disabled, you cannot set up a proxy tunnel.

Step 1

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Network > Proxy tabs.

Step 2

Click Create.

Step 3

In the Create Tunnel dialog box, complete the following fields:
•

Source Address—Type the IP address of the source node (32-bit length) or source subnet (any other
length).

•

Length—Choose the length of the source subnet mask.

•

Destination Address—Type the IP address of the destination node (32-bit length) or destination
subnet (any other length).

•

Length—Choose the length of the destination subnet mask.

Step 4

Click OK.

Step 5

Continue with your originating procedure (NTP).

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

17-90

78-20702-02

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords
DLP- G98 Provision a Firewall Tunnel

DLP-G98 Provision a Firewall Tunnel
Purpose

This task provisions destinations that will not be blocked by the firewall.
Firewall tunnels are only necessary when the proxy server is enabled and a
foreign GCC termination exists, or if static routes cause the GCC network
to access remote networks or devices. You can provision a maximum of 12
firewall tunnels.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G76 Provision DCC/GCC Terminations, page 17-88
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser only

Note

If the proxy server is configured as proxy-only or is disabled, you cannot set up a firewall tunnel.

Step 1

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Network > Firewall tabs.

Step 2

Click Create.

Step 3

In the Create Tunnel dialog box, complete the following fields:
•

Source Address—Type the IP address of the source node (32-bit length) or source subnet (any other
length).

•

Length—Choose the length of the source subnet mask.

•

Destination Address—Type the IP address of the destination node (32-bit length) or destination
subnet (any other length).

•

Length—Choose the length of the destination subnet mask.

Step 4

Click OK.

Step 5

Continue with your originating procedure (NTP).

DLP-G108 Change the Service State for a Port
Purpose

This task puts a port in service or removes a port from service. After
creating an IP-encapsulated tunnel, put the ports that are hosting the
IP-encapsulated tunnel in service.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x
78-20702-02

17-91

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords

DLP- G109 Provision Orderwire

Note

For more information about service states, see the Administrative and Service States document.

Step 1

In node view (single-shelf mode) or shelf view (multishelf mode) on the shelf graphic, double-click the
card with the ports you want to put in or out of service. The card view appears.

Step 2

Click the Provisioning > Line tabs.

Step 3

In the Admin State column for the target port, choose one of the following from the drop-down list:
•

IS (ANSI) or Unlocked (ETSI)—Puts the port in the IS-NR (ANSI) or Unlocked-enabled (ETSI)
service state.

•

OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Puts the port in the OOS-MA,DSBLD (ANSI)
or Locked-enabled,disabled (ETSI) service state.
For ANSI nodes, traffic is not passed on the port until the service state is changed to IS-NR;
OOS-MA,MT; or Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS). For
ETSI nodes, traffic is not passed on the port until the service state is changed to Unlocked-enabled;
Locked-enabled,maintenance; or Unlocked-disabled,automaticInService.

•

OOS,MT (ANSI) or Locked,maintenance (ETSI)—Puts the port in the
OOS-MA,MT/Locked-enabled,maintenance service state. This state does not interrupt traffic flow,
but alarm reporting is suppressed and loopbacks are allowed. Raised fault conditions, whether or not
their alarms are reported, can be retrieved from the CTC Conditions tab or by using the TL1
RTRV-COND command. Use the OOS-MA,MT/Locked-enabled,maintenance administrative state
for testing or to suppress alarms temporarily. Change to the IS-NR/Unlocked-enabled or
OOS-AU,AINS/Unlocked-disabled,automaticInService administrative states when testing is
complete.

•

IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)—Puts the port in the
OOS-AU,AINS/Unlocked-enabled,automaticInService service state. In this state, alarm reporting is
suppressed, but traffic is carried and loopbacks are allowed. After the soak period passes, the port
changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether their alarms are reported or
not, can be retrieved from the CTC Conditions tab or by using the TL1 RTRV-COND command.

Step 4

If you set the Admin State field to IS-AINS or Unlocked,automaticInService, set the soak period time in
the AINS Soak field. This is the amount of time that the port will stay in the OOS-AU,AINS or
Unlocked-enabled,automaticInService state after a signal is continuously received. When the soak
period elapses, the port changes to the IS-NR or Unlocked-enabled state.

Step 5

Click Apply. The new port service state appears in the Service State column.

Step 6

As needed, repeat this task for each port.

Step 7

Return to your originating procedure (NTP).

DLP-G109 Provision Orderwire
Purpose

This task provisions orderwire on the AIC-I card.

Tools/Equipment

An AIC-I card must be installed in Slot 9.
An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G,
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed.
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Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Provisioning > Overhead Circuits tabs.

Step 3

Click Create.

Step 4

In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

Caution

•

Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces).

•

Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire
path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use
either local or express orderwire channels. If regenerators exist, use the express orderwire channel.
You can provision up to four ONS 15454 OC-N/STM-N ports for each orderwire path.

•

PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law
(North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both
types of orderwire.

When provisioning orderwire for ONS 15454 nodes residing in a ring, do not provision a complete
orderwire loop. For example, a four-node ring typically has Side B and Side A ports provisioned at all
four nodes. However, to prevent orderwire loops, provision two orderwire ports (Side B and Side A) at
all but one of the ring nodes.

Step 5

Click Next.

Step 6

In the Circuit Source area, complete the following information:
•

Node—Choose the source node.

•

Shelf—(Multishelf mode only) Choose the source shelf.

•

Slot—Choose the source slot.

•

Port—If applicable, choose the source port.

Step 7

Click Next.

Step 8

In the Circuit Destination area, complete the following information:
•

Node—Choose the destination node.

•

Shelf—(Multishelf mode only) Choose the destination shelf.

•

Slot—Choose the destination slot.

•

Port—If applicable, choose the destination port.

Step 9

Click Finish.

Step 10

Return to your originating procedure (NTP).

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x
78-20702-02

17-93

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords

DLP- G110 Create a User Data Channel Circuit

DLP-G110 Create a User Data Channel Circuit
Purpose

This task creates a UDC circuit on the ONS 15454. A UDC circuit allows
you to create a dedicated data channel between nodes.

Tools/Equipment

An OSCM, OSC-CSM, MXPP_MR_2.5G, or MXP_MR_2.5G card must
be installed.

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Provisioning > Overhead Circuits tabs.

Step 3

Click Create.

Step 4

In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:
•

Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces).

•

Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down list.
(User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 5

Click Next.

Step 6

In the Circuit Source area, complete the following information:
•

Node—Choose the source node.

•

Shelf—(Multishelf mode only) Choose the source shelf.

•

Slot—Choose the source slot.

•

Port—If applicable, choose the source port.

Step 7

Click Next.

Step 8

In the Circuit Destination area, complete the following information:
•

Node—Choose the destination node.

•

Shelf—(Multishelf mode only) Choose the destination shelf.

•

Slot—Choose the destination slot.

•

Port—If applicable, choose the destination port.

Step 9

Click Finish.

Step 10

Return to your originating procedure (NTP).
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DLP-G112 Delete Overhead Circuits
Purpose

This task deletes overhead circuits. Overhead circuits include
IP-encapsulated tunnels, AIC-I card orderwire, and UDCs.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Caution

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Deleting overhead circuits is service affecting if the circuits are in service (IS). To put circuits out of
service (OOS), see the “DLP-G108 Change the Service State for a Port” task on page 17-91.

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Provisioning > Overhead Circuits tabs.

Step 3

Click the overhead circuit that you want to delete: local or express orderwire, user data, IP-encapsulated
tunnel, or DCC tunnel.

Step 4

Click Delete.

Step 5

In the confirmation dialog box, click Yes to continue.

Step 6

Return to your originating procedure (NTP).

NTP-G62 Create a J0 Section Trace
Purpose

This procedure creates a repeated, fixed-length string of characters used to
monitor interruptions or changes to traffic between nodes.

Tools/Equipment

One TXP or MXP card must be installed.

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE,
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards,
page 14-69
DLP-G223 Change the 4x2.5G Muxponder Line Settings, page 11-285
(if necessary)
DLP-G224 Change the 4x2.5G Muxponder Section Trace Settings,
page 11-287

Step 1

Required/As Needed

As needed (optional if path trace is set)

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Complete the DLP-G46 Log into CTC at a node on the network where you will create the section trace.
If you are already logged in, continue with Step 2.
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Step 2

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card.

Step 3

Click the Provisioning > Line > Section Trace tabs.

Step 4

From the Port drop-down list, choose the port for the section trace.

Step 5

From the Received Trace Mode drop-down list, enable the section trace expected string by choosing
Manual.

Step 6

In the Transmit Section Trace String Size area, click 1 byte or 16 byte. The 1 byte option allows you to
enter one character and the 16 byte option allows a 15 character string.

Step 7

In the New Transmit String field, enter the string that you want to transmit. Enter a string that makes the
destination port easy to identify, such as the node IP address, node name, or another string. If the
New Transmit String field is left blank, the J0 transmits a string of null characters.

Step 8

If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive
from the source port in the New Expected String field.

Step 9

If the card's Termination mode is set to Line, click the Disable AIS and RDI if TIM-P is detected check
box if you want to suppress the alarm indication signal (AIS) and remote defect indication (RDI) when
the STS Section Trace Identifier Mismatch Path (TIM-P) alarm appears. If the card's Termination mode
is set to Section, the Disable AIS and RDI if TIM-P is detected check box will be grayed out and you
will not be able to select it. Continue on to Step 10. Refer to the Cisco ONS 15454 DWDM
Troubleshooting Guide for descriptions of alarms and conditions.

Step 10

Click Apply.

Step 11

After you set up the section trace, the received string appears in the Received field. The following
options are available:

Caution

•

Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII
Mode. Click ASCII Mode to return the section trace to ASCII format.

•

Click the Reset button to reread values from the port.

•

Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the
New Transmit and New Expected Strings are null).

Clicking Default will generate alarms if the port on the other end is provisioned with a different string.
The expect and receive strings are updated every few seconds.
Stop. You have completed this procedure.

NTP-G203 Create End-to-End SVLAN Circuits
Purpose

This procedure manually creates an end-to-end SVLAN circuit for the
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards provisioned in
L2-over-DWDM mode.

Tools/Equipment

None

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

17-96

78-20702-02

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords
DLP- G112 Delete Overhead Circuits

Prerequisite Procedures DLP-G46 Log into CTC
DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card
Mode, page 11-170
DLP-G421 Create and Store an SVLAN Database, page 17-85
NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-34
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits > SVLAN tabs.

Step 3

Click Create.

Step 4

Define the circuit attributes:
•

Name—Assign a name to the source SVLAN circuit. The name can be alphanumeric and up to 48
characters (including spaces). If you leave the field blank, CTC assigns a default name to the source
cross-connect.

•

Type—(Display only) SVLAN.

•

SVLAN ID—Displays the SVLAN identifier. Enter a SVLAN ID between 1 and 4093.

Note
•

Do not duplicate SVLAN IDs.

Protection—Before enabling SVLAN protection be sure to define the master node in the OCH Ring
that contains the circuit. Protection must be enabled in order to have a SVLAN protected circuit
provisioned.
Check/uncheck to enable/disable SVLAN protection. A maximum of 1024 SVLANs can be
protected.

Step 5

Click Next.

Step 6

Provision the circuit source (UNI or NNI client interfaces):
a.

From the Node drop-down list, choose the circuit source node.

b.

From the Slot drop-down list, choose the slot where the card exists.

c.

From the Port drop-down list, choose the port where the circuit must originate (UNI or NNI client
ports).

Step 7

Click QinQ Settings. Provision the IEEE 802.1QinQ VLAN tags on the GE_XP, 10GE_XP, GE_XPE,
or 10GE_XPE cards. See the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
QinQ Settings” task on page 11-421.

Step 8

Click Next.

Step 9

Provision the circuit destination (UNI or NNI client interfaces):
a.

From the Node drop-down list, choose the circuit destination node.

b.

From the Slot drop-down list, choose the slot where the card exists.

c.

From the Port drop-down list, choose the port where the circuit must terminate (UNI or NNI client
ports).
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Step 10

Click QinQ Settings. Provision the IEEE 802.1QinQ VLAN tags on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards. See DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
QinQ Settings, page 11-421.

Step 11

Click Next.

Step 12

The SVLAN Circuit Routing Preview pane provides the following information:
•

SVLAN Circuit Path—Nodes and spans. Click a node to select it. Blue arrows show the new SVLAN
route. Move your cursor over the arrow to view span information including source, destination, and
span loss information.

•

Selected Node—Node that is currently chosen in the graphic. All actions that are invoked will apply
to this node.

•

Included Nodes—Nodes that are included in the circuit path.

•

Excluded Nodes—Nodes that are excluded from the circuit path.

•

Include—Includes the node displayed in the Selected Node field in the circuit path. Click Apply to
update the circuit with the new constraints. This option is not applicable for protected SVLAN
circuits.

•

Exclude—Excludes the node displayed in the Selected Node field from the circuit path. Click Apply
to update the circuit with the new constraints. This option is not applicable for protected SVLAN
circuits.

Step 13

Click Finish to complete the circuit creation.

Step 14

To edit the SVLAN circuit, see instructions described in the “DLP-G472 Edit the End-to-End SVLAN
Circuit” section on page 17-98.
Stop. You have completed this procedure.

DLP-G472 Edit the End-to-End SVLAN Circuit
Purpose

This task edits an end-to-end SVLAN circuit.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits > SVLAN tabs.

Step 3

Select the SVLAN circuit that you want to edit and click Edit.
The Edit Circuit pane appears.
•

Use the General tab to view circuit information (circuit type, size, protection type, and routing
preference), and to modify the circuit name.

•

Use the End Points tab to view and define new circuit drops for the SVLAN circuit.
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Step 4

Return to your originating procedure (NTP).

NTP-G229 Provision DCN Extension for a Network Using
GCC/DCC
Purpose

This procedure provisions a DCN extension for a network using GCC/DCC
as the communication channel

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the DLP-G46 Log into CTC at a node on the network (for example, Node A) where you want
to provision the DCN extension. If you are already logged in, continue with Step 2.

Step 2

Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 17-45, to
create an OCHNC DCN circuit for the wavelength of the transponder (TXP) to be used for the GCC
channel.

Step 3

Complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 17-88, to create a GCC
service channel on the transponder in Node A.

Step 4

Complete the DLP-G46 Log into CTC at another node on the network (for example, Node B) where you
want to provision the DCN extension.

Step 5

Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 17-45, to
create an OCHNC DCN circuit for the wavelength of the transponder to be used for the GCC channel.

Step 6

Complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 17-88, to create a GCC
service channel on the transponder in Node B.

Step 7

Turn up the circuit by forcing an ALS manual restart on the line-facing amplifier:
a.

Double-click the line-facing amplifier card

b.

Click the Maintenance > ALS tabs.

c.

From the ALS Mode drop-down list, choose Manual Restart.

d.

Click Apply. Click Yes in the confirmation dialog box.

Step 8

When the circuit is up, CTC discovers the GCC topology and shows the two nodes (Node A and B)
connected by the GCC link.

Step 9

Complete the “NTP-G184 Create a Provisionable Patchcord” task on page 17-78, to create an
OTS-to-OTS PPC between the two nodes.

Step 10

Complete the “DLP-G472 Merge two OCHNC DCN Circuits” task on page 17-100, to merge the two
OCHNC DCN circuits into a single OCHNC circuit.
Stop. You have completed this procedure.
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DLP-G472 Merge two OCHNC DCN Circuits
Purpose

This task merges two OCHNC DCN circuits into a single OCHNC circuit

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the View menu, choose Go to Network View.

Step 2

Click the Circuits tab.

Step 3

Select one of the OCHNC DCN circuits that you want to merge and click Edit. The Edit Circuit pane
appears.

Step 4

Click Merge tab.

Step 5

Select the other OCHNC DCN circuit that you want to merge and click Merge.

Step 6

Return to your originating procedure (NTP).

NTP-G245 Create an Automatically Routed VCAT Circuit
Purpose

This procedure creates an automatically routed VCAT circuit.

Tools/Equipment

ADM-10G card.

Prerequisite Procedures ADM-10G card must be installed at the nodes used in the VCAT circuit.
Chapter 14, “Turn Up a Node”

Note

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

Provisioning or higher

This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE
default are set to FALSE. To view the NE default values, go to Shelf View and click the
Provisioning->NE Defaults tab. For a full description of these defaults, see the Network Element
Defaults section.

Step 1

Complete the DLP-G46 Log into CTC at the node where you would create the VCAT circuit. If you are
already logged in, continue with Step 2.

Step 2

You must provision Ethernet or POS ports first before creating a VCAT circuit. Complete the following
as necessary:
•

To provision Ethernet ports for ADM-10G circuits, complete the “DLP-G551 Provision ADM-10G
Ethernet Ports” task on page 17-107.

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

17-100

78-20702-02

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords
DLP- G472 Merge two OCHNC DCN Circuits

•

To provision a VCAT circuit that traverses through a third-party network, complete the “DLP-G553
Create a Server Trail” procedure on page 17-108.

Step 3

From the View menu, choose Go to Network View.

Step 4

Click the Circuits tab, then click Create.

Step 5

In the Circuit Creation dialog box, choose STS-V or VC_HO_PATH_VCAT_CIRCUIT from the
Circuit Type drop-down list. Click Next.

Step 6

Define the circuit attributes as follows:
•

Name—Type the circuit name. The name can be alphanumeric and up to 48 characters (including
spaces). Circuit names should be 43 characters or less if you want the ability to create monitor
circuits. If you leave the field blank, CTC assigns a default name to the circuit. Monitor circuits are
secondary circuits that monitor traffic on primary bidirectional circuits.

•

Type—Displays the circuit type you chose in Step 5.

•

Bidirectional—Checked by default and creates a bidirectional circuit.

•

Create cross-connects only (TL1-like)—Check this check box if you want to create one or more
cross-connects to complete a signal path for TL1-generated circuits.

•

Apply to drop ports—Check this check box to apply the IS administrative state to the circuit source
and destination ports. The IS state is applied to the ports only if the circuit bandwidth is the same as
the port bandwidth, or if the port bandwidth is larger than the circuit, the circuit must be the first
circuit to use the port. If not, a Warning dialog box shows the ports where the administrative state
could not be applied. If the check box is unchecked, CTC does not change the service state of the
source and destination ports.

Note

If the ports in the IS-state do not receive signals, then the loss of signal alarms are generated.
This transitions the ports from the IS state to OOS-AU,FLT state.

•

Symmetric—Checked by default. A bi-directional symmetrical VCAT circuit consists of only one
VCAT member group. All member circuits are bi-directional circuits.

•

Open VCAT—Check this check box to create open-ended VCAT circuits.

•

Member size—Choose the member size. Choose the size of each member circuit in the VCG.
STS1/STS3c for ANSI and VC4 for ETSI. For information about the member size that ADM-10G
card supports, see Chapter 11, “Provision Transponder and Muxponder Cards”.

•

Num. of members—Choose the number of members. The number of members defines how much
bandwidth is required at the trunk. Thus depending on bandwidth requirements of the ethernet traffic
on the GE ports, choose appropriate number of members. For information about the number of
members that ADM-10G card supports, see Chapter 11, “Provision Transponder and Muxponder
Cards”.

Note

•

In ADM-10G cards, the Gigabit Ethernet port does not support flow control. When less than
seven VC-4s are configured for the port, with the client traffic expected to be below the line rate,
a burst in traffic beyond the supposed bandwidth leads to packet loss. It is, therefore,
recommended to use an external flow control mechanism with less than seven VC-4s configured.
Connecting a GE-XP or GE-XPE card between the client traffic and the ADM-10G Gigabit
Ethernet interface enables such flow control.
Mode—Select “None”. The ADM-10G card supports only pure VCAT and does not support
SW-LCAS or HW-LCAS.
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Note

A failure on one member causes the entire VCAT circuit to fail. For ADM-10G card, you can add or
delete members after creating a VCAT circuit with no protection. But while adding or deleting the
members, the entire VCAT circuit does not carry traffic.

Step 7

Click Next.

Step 8

Complete the “DLP-G555 Provision a VCAT Circuit Source and Destination” task on page 17-111 for
the VCAT circuit you are creating. If you are creating an open-ended VCAT circuit, complete the
“DLP-G556 Provision an Open VCAT Circuit Source and Destination” task on page 17-111.

Step 9

In the VCAT Circuit Routing Preferences area, choose Route Automatically. The following options are
available (choose either, both, or none based on your preferences).
•

Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or
exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the working path
of the circuit (but not the protect path). Excluding nodes and spans ensures that the nodes and spans
are not in the working or protect path of the circuit.

•

Step 10

Review Route Before Creation—Check this check box to review and edit the circuit route before the
circuit is created (you can see all the spans the circuit is traversing before the circuit creation is
completed).

If the VCAT circuit has a source or destination on a ADM-10G card, choose one of the following routing
types.
•

Common Routing—Routes the members on the same fiber.

•

Split Routing—Allows the individual members to be routed on different fibers or each member to
have different routing constraints. Split routing is required when creating circuits over a path
protection configuration.

If the VCAT circuit does not have a source or destination on a ADM-10G card, common routing is
automatically selected and you cannot change it.
Step 11

If you want to set preferences for individual members, complete the following in the Member
Preferences area. Repeat for each member. To set identical preferences for all members, skip this step
and continue with Step 12:
•

Number—Choose a number (between 1 and 256) from the drop-down list to identify the member.

•

Name—Type a unique name to identify the member. The name can be alphanumeric and up to
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to the
circuit.

•

Protection—Choose the member protection type:
– Fully Protected—Routes the circuit on a protected path.
– Unprotected—Creates an unprotected circuit.
– PCA—Routes the circuit on a BLSR protection channel.
– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.

•
Step 12

Node-Diverse Path—(Split routing only) Available for each member when Fully Protected is
chosen.

To set preferences for all members, complete the following in the Set Preferences for All Members area:
•

Protection—Choose the member protection type:
– Fully Protected—Routes the circuit on a protected path.

Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

17-102

78-20702-02

Chapter 17

Create Optical Channel Circuits and Provisionable Patchcords
DLP- G472 Merge two OCHNC DCN Circuits

– Unprotected—Creates an unprotected circuit.
– PCA—Routes the member on a BLSR protection channel.
– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.
•

Node-Diverse Path—(Split routing only) Available when Fully Protected is chosen.

Step 13

Click Next. If you chose Fully Protected or PCA, click OK to continue. If not, continue with the next
step.

Step 14

If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue
with Step 15:

Step 15

Step 16

a.

In the Circuit Constraints area, choose the member that you want to route from the Route member
number drop-down list.

b.

Click a node or span on the circuit map.

c.

Click Include to include the node or span in the circuit, or click Exclude to exclude the node or span
from the circuit. The order in which you choose included nodes and spans is the order in which the
circuit is routed. Click spans twice to change the circuit direction.

d.

Repeat Steps b and c for each node or span you wish to include or exclude.

e.

Review the circuit route. To change the circuit routing order, choose a node in the Required
Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons to change the circuit
routing order. Click Remove to remove a node or span.

f.

Repeat Steps a through e for each member.

If you selected Review Route Before Creation in Step 9, complete the following substeps. If not continue
with Step 16:
a.

In the Route Review/Edit area, choose the member that you want to route from the Route Member
Number drop-down list.

b.

Click a node or span on the circuit map.

c.

Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue
arrows indicate the circuit route. Green arrows indicate spans that you can add. Click a span
arrowhead, then click Include to include the span or Remove to remove the span.

d.

If the provisioned circuit does not reflect the routing and configuration you want, click Back to
verify and change circuit information. If the circuit needs to be routed to a different path, see the
“NTP-G246 Create a Manually Routed VCAT Circuit” procedure on page 17-104 to assign the
circuit route yourself.

e.

Repeat Steps a through d for each member.

Click Finish. The Circuits window appears.

Note

Step 17

Depending on the complexity of the network and number of members, the VCAT circuit creation
process can take several minutes.

In the Circuits window, verify that the circuit you created appears in the circuits list.
Stop. You have completed this procedure.
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NTP-G246 Create a Manually Routed VCAT Circuit
Purpose

This procedure creates a manually routed VCAT circuit.

Tools/Equipment

ADM-10G card.

Prerequisite Procedures ADM-10G card must be installed at the nodes used in the VCAT circuit.
Chapter 14, “Turn Up a Node”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the DLP-G46 Log into CTC at the node where you would create the circuit. If you are already
logged in, continue with Step 2.

Step 2

If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with Step 3.

Step 3

You must provision Ethernet or POS ports first before creating a VCAT circuit. Complete the following
as necessary:
•

To provision Ethernet ports for ADM-10G circuits, complete the “DLP-G551 Provision ADM-10G
Ethernet Ports” task on page 17-107.

•

To provision a VCAT circuit that traverses through a third-party network, complete the “DLP-G553
Create a Server Trail” procedure on page 17-108.

Step 4

From the View menu, choose Go to Network View.

Step 5

In the Circuit Creation dialog box, choose STS-V or VC_HO_PATH_VCAT_CIRCUIT from the
Circuit Type drop-down list. Click Next.

Step 6

Define the circuit attributes as follows:
•

Name—Type the circuit name. The name can be alphanumeric and up to 48 characters (including
spaces). Circuit names should be 43 characters or less if you want the ability to create monitor
circuits. If you leave the field blank, CTC assigns a default name to the circuit.

•

Type—Displays the circuit type you chose in Step 5.

•

Bidirectional—Checked by default and creates a bidirectional circuit.

•

Create cross-connects only (TL1-like)—Check this check box if you want to create one or more
cross-connects to complete a signal path for TL1-generated circuits.

•

Apply to drop ports—Check this check box to apply the IS administrative state to the circuit source
and destination ports. The IS state is applied to the ports only if the circuit bandwidth is the same as
the port bandwidth, or if the port bandwidth is larger than the circuit, the circuit must be the first
circuit to use the port. If not, a Warning dialog box shows the ports where the administrative state
could not be applied. If the check box is unchecked, CTC does not change the service state of the
source and destination ports.

•

Symmetric—Checked is the default. A bi-directional symmetrical VCAT circuit consists of only one
VCAT member group. All member circuits are bi-directional circuits.

•

Open VCAT—Check this check box to create open-ended VCAT circuits.

•

Member size—Choose the member size. Choose the size of each member circuit in the VCG.
STS1/STS3c for ANSI and VC4 for ETSI. For information about the member size that ADM-10G
card supports, see Chapter 11, “Provision Transponder and Muxponder Cards”.
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•

Note

•

Note

Num. of members—Choose the number of members. The number of members defines how much
bandwidth is required at the trunk. Thus depending on bandwidth requirements of the ethernet traffic
on the GE ports, choose appropriate number of members. For information about the number of
members that ADM-10G card supports, see Chapter 11, “Provision Transponder and Muxponder
Cards”.

In ADM-10G cards, the Gigabit Ethernet port does not support flow control. When less than
seven VC-4s are configured for the port, with the client traffic expected to be below the line rate,
a burst in traffic beyond the supposed bandwidth leads to packet loss. It is, therefore,
recommended to use an external flow control mechanism with less than seven VC-4s configured.
Connecting a GE-XP or GE-XPE card between the client traffic and the ADM-10G Gigabit
Ethernet interface enables such flow control.
Mode—ADM-10G card supports only pure VCAT and does not support SW-LCAS or HW-LCAS.

A failure on one member causes the entire VCAT circuit to fail. For ADM-10G card, you can add or
delete members after creating a VCAT circuit with no protection. But while adding or deleting the
members, the entire VCAT circuit does not carry traffic.

Step 7

Click Next.

Step 8

Complete the “DLP-G555 Provision a VCAT Circuit Source and Destination” task on page 17-111 for
the VCAT circuit you are creating. If you are creating an open-ended VCAT circuit, complete the
“DLP-G556 Provision an Open VCAT Circuit Source and Destination” task on page 17-111.

Step 9

In the Circuit Routing Preferences area, uncheck Route Automatically.

Step 10

If the VCAT circuit has a source or destination on a ADM-10G card, choose one of the following routing
types.
•

Common Routing—Routes the members on the same fiber.

•

Split Routing—Allows the individual members to be routed on different fibers or each member to
have different routing constraints. Split routing is required when creating circuits over a path
protection configuration.

If the VCAT circuit does not have a source or destination on a ADM-10G card, common routing is
automatically selected and you cannot change it.
Step 11

If you want to set preferences for individual members, complete the following in the Member
Preferences area. Repeat for each member. To set identical preferences for all members, skip this step
and continue with Step 12.
•

Number—Choose a number (between 1 and 256) from the drop-down list to identify the member.

•

Name—Type a unique name to identify the member. The name can be alphanumeric and up to
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to the
circuit.

•

Protection—Choose the member protection type:
– Fully Protected—Routes the circuit on a protected path.
– Unprotected—Creates an unprotected circuit.
– PCA—Routes the member on a BLSR protection channel.
– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.
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•
Step 12

Node-Diverse Path—(Split routing only) Available for each member when Fully Protected is
chosen.

To set preferences for all members, complete the following in the Set Preferences for All Members area:
•

Protection—Choose the member protection type:
– Fully Protected—Routes the circuit on a protected path.
– Unprotected—Creates an unprotected circuit.
– PCA—Routes the member on a BLSR protection channel.
– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.

•

Node-Diverse Path—(Split routing only) Available when Fully Protected is chosen.

Step 13

Click Next. If you chose Fully Protected or PCA, click OK. If not, continue with the next step.

Step 14

In the Route Review and Edit area, node icons appear so you can route the circuit manually.

Step 15

Complete the “DLP-G557 Provision a VCAT Circuit Route” task on page 17-112.

Step 16

Click Finish. If the path does not meet the specified path diversity requirement, CTC displays an error
message and allows you to change the circuit path.

Note

Step 17

Depending on the complexity of the network and number of members, the VCAT circuit creation
process can take several minutes.

When all the circuits are created, the main Circuits window appears. Verify that the circuit you created
appears in the window.
Stop. You have completed this procedure.

NTP-G247 Enable or disable Path Performance Monitoring on
Intermediate Nodes

Note

Purpose

This task enables or disables path performance monitoring on STS
circuits of intermediate nodes carrying high volume traffic.

Tools/Equipment

None

Prerequisite Procedures

DLP-G46 Log into CTC

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

For PM parameter definitions, see the 11.15.15 Performance Monitoring Parameter Definitions,
page 11-94 section.

Step 1

In node view, double-click the ADM-10G card to display the card view.

Step 2

Click the Provisioning > Line > SONET STS tabs
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Step 3

In the Provisioning->Line->SONET STS pane, check the Enable IPPM check box to enable path
performance monitoring on the STS circuit. Uncheck (default option) the Enable IPPM to disable path
performance monitoring on the STS circuit.

Step 4

Click Apply.

Step 5

Click the Performance tab to view PM parameters.

Step 6

Return to your originating procedure (NTP).

DLP-G551 Provision ADM-10G Ethernet Ports
Purpose

This task provisions ADM-10G Ethernet ports to carry traffic.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete DLP-G411 Provision an ADM-10G PPM and Port, page 11-171 to provision the PPM.

Step 2

In node view (single-shelf view) or shelf view (multishelf view), double-click the ADM-10G card to
display the card view.

Step 3

Click the Provisioning > Line > Ethernet tabs.

Step 4

For each ADM-10G port, provision the following parameters:
•

Port Name—Enter a logical name that defines the port.

•

Admin State—Select the service state from the drop-down list. See the “DLP-G108 Change the
Service State for a Port” task on page 17-91 for more information.

•

MTU—The maximum size of the Ethernet frames accepted by the port. For jumbo size Ethernet
frames, choose jumbo (the valid range is 64-9216) or select 1548 (default).

•

Framing Type—Choose GPF-F POS framing (the default) or HDLC POS framing. The framing
type needs to match the framing type of the POS device at the end of the circuit.

•

CRC Encap—With GFP-F framing, you can configure a 32-bit cyclic redundancy check (CRC) or
none (no CRC) (the default). HDLC framing provides a set 16-bit or 32-bit CRC. The encap and
CRC should be set to match the encap and CRC of the POS device on the end of the circuit.

Step 5

Click Apply.

Step 6

Refresh the statistics to get the current RMON counts:

Step 7

a.

Click the Performance > Statistics tabs.

b.

Click Refresh.

Return to your originating procedure (NTP).
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DLP-G553 Create a Server Trail
Purpose

This procedure creates a server trail, which provides a connection between
ONS nodes through a third-party network. You can create server trails
between any two optical ports.

Tools/Equipment

None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

You cannot create server trails on ports with DCC links.

Step 1

Complete the DLP-G46 Log into CTC at the node where you would create the circuit. If you are already
logged in, continue with Step 2.

Step 2

From the View menu, choose Go to Network View.

Step 3

Click the Provisioning > Server Trails tabs.

Step 4

Click Create.

Step 5

In the Server Trail Creation dialog box, complete the following fields:
•

Type—Choose STS or VC.

•

Size—Depending on the type selected, choose the server trail size. For STSs, choose STS-1,
STS-3c, STS-6c, STS-9c, STS-12c, or STS-24c; for VCs, choose VC-4, VC-4-2c, VC-4-3c,
VC-4-4c, or VC4-8c

•

Protection Type—Choose one of the following protection types: Preemptible, Unprotected, or
Fully Protected. The server trail protection sets the protection type for any circuit that traverses it.
– Preemptible— PCA circuits will use server trails with the Preemptible attribute.
– Unprotected—In Unprotected Server Trail, CTC assumes that the circuits going out from that

specific port will not be protected by provider network and will look for a secondary path from
source to destination if you are creating a protected circuit.
– Fully Protected—In Fully Protected Server Trail, CTC assumes that the circuits going out from

that specific port will be protected by provider network and will not look for a secondary path
from source to destination.
•

Number of Trails—Enter the number of server trails. Number of trails determine the number of
circuits that can be created on server trail. You can create a maximum of 3744 server trails on a node.
You can create multiple server trails from the same port. This is determined by how many circuits
of a particular server trail size can be supported on the port.

•

SRLG—Enter a value for the Shared Resource Link Group (SRLG). SRLG is used by Cisco
Transport Manager (CTM) to specify link diversity. The SRLG field has no restrictions. If you create
multiple server trails from one port, you can assign the same SRLG value to all the links to indicate
that they originate from the same port.

Step 6

Click Next.

Step 7

In the Source area, complete the following:
•

From the Node drop-down list, choose the node where the server trail originates.
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•

From the Slot drop-down list, choose the slot containing the card where the server trail originates.
(If a card’s capacity is fully utilized, the card does not appear in the list.)

•

Depending on the origination card, choose the source port and/or STS or VC from the Port and STS
or VC lists. The Port list is only available if the card contains multiple ports. STSs and VCs do not
appear if they are already in use by other circuits.

Step 8

Click Next.

Step 9

In the Destination area, complete the following:

Step 10

Note

•

From the Node drop-down list, choose the destination node.

•

From the Slot drop-down list, choose the slot containing the card where the server trail will
terminate (destination card). (If a card’s capacity is fully utilized, the card does not appear in the
list.)

•

Depending on the card selected, choose the destination port and/or STS or VC from the Port and
STS or VC drop-down lists. The Port drop-down list is available only if the card has multiple ports.
The STSs that appear depend on the card, circuit size, and protection scheme.

Click Finish.

When Server Trails are created on an IPv4 or IPv6 node and the IP address of the node changes, complete
the “DLP-G554 Repair Server Trails” task on page 17-109 to repair the Server Trails.
Stop. You have completed this procedure.

DLP-G554 Repair Server Trails
Purpose

This procedure repairs server trail terminations in cases where the IP
address changes for a node connected by a Server Trail link.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

The Server Trail Repair wizard can only fix the IP address changes and cannot fix Server Trail
terminations when you migrate from IPv4 to IPv6 addresses.

Note

The Server Trail Repair wizard cannot repair the server trails when IP address of nodes on both ends of
the Server Trail are changed.
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Note

When server trails are created on an IPv4 or IPv6 node and the IP address of the node changes, make
sure that the Server Trail Repair wizard is launched on the IP address of the node that changed. For
example, if the IP address of server trails created on an IPv4 node changes, run the Server Trail Repair
wizard on the IPv4 node and not on the IPv6 node.

Step 1

Complete the DLP-G46 Log into CTC at the node where you would repair server trails. If you are already
logged in, continue with Step 2.

Note

The Server Trail Repair wizard works only when nodes at both ends of the server trail are added
in the CTC. If CTC is launched after the IP address is changed or if the node on any of the sides
is not discovered automatically, then the node has to be added manually into the CTC.

Step 2

From the View menu, choose Go to Network View.

Step 3

Choose the Tools > Links > Repair Server Trails option from the tool bar.
The Server Trail Repair wizard appears.

Step 4

Specify the changed IP address.
The Server Trail Repair window provides the following options:
•

Try to discover IP address changes—The wizard searches and displays the list of changed IP
addresses.

Note

•

The wizard can discover multiple IP address changes. However, the wizard can repair only
one IP address change at a time. To repair multiple IP address changes, run the Server Trail
Repair wizard multiple times.

Apply the following IP change—Allows you to specify the changed IP address.
Select the node with the changed IP address and specify old IP address as Original IP Address. The
wizard automatically displays the current IP address.

Step 5

Click Next.
If you selected the “Try to discover IP address changes” option in Step 4, then the wizard displays all
the IP address changes that will be fixed. Click Next.
If you selected the “Apply the following IP change” option in Step 4, continue with Step 6.

Step 6

The Server Trail Terminations to Repair window appears. Click Finish to repair the server trails.
Stop. You have completed this procedure.
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DLP-G555 Provision a VCAT Circuit Source and Destination
Purpose

This task provisions a virtual concatenated (VCAT) circuit source and
destination.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

After you have selected the circuit properties in the Circuit Source dialog box according to the specific
circuit creation procedure, you are ready to provision the circuit source.

Step 1

From the Node drop-down list (in the Source/Destination selection pane), choose the node where the
circuit originates.

Step 2

From the Slot drop-down list, choose the slot containing the ADM-10G card where the circuit originates.
(If a card’s capacity (bandwidth) is fully utilized, it does not appear in the list.)

Step 3

Depending on the circuit origination card, choose the source port.

Step 4

Click Next.

Step 5

From the Node drop-down list, choose the destination node.

Step 6

From the Slot drop-down list, choose the slot containing the ADM10-G card where the circuit will
terminate (destination card). (If a card’s capacity (bandwidth) is fully utilized, the card does not appear
in the list.)

Step 7

Choose the destination port.

Step 8

Click Next.

Step 9

Return to your originating procedure (NTP).

DLP-G556 Provision an Open VCAT Circuit Source and Destination
Purpose

This task provisions an open virtual concatenated (VCAT) circuit source
and destination.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

After you have selected the circuit properties in the Circuit Source dialog box according to the specific
circuit creation procedure, you are ready to provision the circuit source.
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Step 1

From the Node drop-down list (in the Source/Destination selection pane), choose the node where the
circuit originates.

Step 2

From the Slot drop-down list, choose the slot containing the ADM-10G card where the circuit originates.
(If a card’s capacity (bandwidth) is fully utilized, it does not appear in the list.)

Step 3

Depending on the circuit origination card, choose the source port.

Step 4

Click Next.

Step 5

Click the Auto-ranged Destinations check box to select the endpoints (CCAT/VCAT) automatically.
Only the first endpoint needs to be selected; all the other endpoints are automatically created.
If you have not chosen auto-ranged destinations from the card selected in Step 2, then choose the source
port and/or STS. If applicable, choose VC from the Port and STS drop down-lists. The Port drop-down
list is available only if the card has multiple ports. STSs and VCs do not appear if they are already in use
by other circuits.

Step 6

From the Select Destinations For drop-down list, choose the member number.

Step 7

From the Node drop-down list, choose the destination node.

Step 8

From the Slot drop-down list, choose the slot containing the card where the circuit will terminate
(destination card). (If a card’s capacity (bandwidth) is fully utilized, the card does not appear in the list.)
Non-data cards may be used for open VCAT circuits. The cards that do not have ethernet ports are
non-data cards.

Step 9

Click Add Destinations.

Step 10

Click Next.

Step 11

Verify that the open VCAT circuit source and destination appears.

Step 12

Return to your originating procedure (NTP).

DLP-G557 Provision a VCAT Circuit Route
Purpose

This task provisions the circuit route for manually routed VCAT circuits.

Tools/Equipment

None

Prerequisite Procedures DLP-G46 Log into CTC
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

In the Circuit Creation wizard in the Route Review and Edit area, choose the member number from the
Route Member Number drop-down list.

Step 2

Click the source node icon if it is not already selected.

Step 3

Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The
arrow turns yellow. In the Selected Span area, the From and To fields provide span information. The
source STS or VC appears.

Step 4

Click Add Span. The span is added to the Included Spans list and the span arrow turns blue.
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Step 5

Repeat Steps 3 and 4 until the circuit is provisioned from the source to the destination node through all
intermediary nodes.

Step 6

Repeat Steps 1 through 5 for each member.

Step 7

Verify that a VCAT circuit route is provisioned.

Step 8

Return to your originating procedure (NTP).
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